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Safety Information 

 

There is a danger of a new battery exploding if it is incorrectly installed. 

Replace the battery pack only with the same or equivalent type recommended 

by the manufacturer. Do not dispose of the battery along with household waste. 

Contact your local waste disposal agency for the address of the nearest battery 

deposit site. 

This product also uses a lithium coin cell battery. The lithium coin cell battery is a long-life 

battery, and it is very possible that you will never need to replace it. However, should you 

need to replace it, consult your service documentation. Do not dispose of the battery along 

with household waste. Contact your local waste disposal agency for the address of the 

nearest battery deposit site. 

Following are the safety agency certifications that the xStack Storage enclosure has met: 

� CSA 60950-1 

� UL 60950-1 

� IEC 60950-1 

� EN 60950-1 

Compliance Information 

� FCC Class A 

� CE Class A 

� C-Tick Class A 

� VCCI Class A 

Notice of Export Controls 

Export of technical data contained in this document may require an export license from the 

United States government. Please contact D-Link Systems, Inc. for any export compliance 

questions. 
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Document Revision Level 

Revision Date Notes 

Version 1.0 August 10, 2006  

Version 1.1 March 7, 2007 Version 1.1, replaces Version 1.0 

- Revises drive numbering schema to reflect proper drive numbers 0 through 

14 instead of 1 through 15. 

Version 2.0 September 20, 2007 Version 2.0, replaces Version 1.1 

- Revisions include product functionality, diagnostics, out-of-box-experience 

(OOBE). 
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Preface 

This User’s Guide assumes that the user is computer literate and is familiar with Storage 

Array Products, has a basic understanding of storage products and concepts, and understands 

the Host Operating Software supported by this product 

Typographic Conventions 

Notes 

Notes provide information that deserves special attention. They are preceded by:  

Cautions 

Cautions contain information which, if not followed, can cause damage to the 

xStack Storage unit. They are preceded by:  

Warnings 

Warnings contain information which, if not followed, can cause damage to the 

xStack Storage unit and to the person installing it. They are preceded by:  
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Contact Information 

You can find software updates and user documentation on the D-Link website. 

D-Link provides free technical support for customers within the United States and within 

Canada for the duration of the warranty period on this product. 

U.S. and Canadian customers can contact D-Link Technical Support through our website, or 

by phone. 

 
Tech Support for customers within the United States: 
D-Link Technical Support over the Telephone 
Please see our support site for current number: 

• http://support.dlink.com 

• Monday to Friday 8:00am – 5:00pm PST/PDT 
 
D-Link Technical Support over the Internet: 

• http://support.dlink.com 
 
Tech Support for customers within Canada: 
D-Link Technical Support over the Telephone 
Please see our support site for current number: 

• http://support.dlink.ca 

• Monday to Friday 7:30am to 9:00pm EST/EDT 
 
D-Link Technical Support over the Internet: 

• http://support.dlink.ca 
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Chapter 1 Introduction 

The xStack Storage Array is an intelligent, high-performance iSCSI Gigabit Ethernet storage 

solution designed for businesses that want to improve the reliability, availability, serviceability, 

and performance of their storage systems.  

Based on an Internet Protocol-Storage Area Network (IP-SAN) architecture, the xStack Storage 

controller is built around a custom-designed Application Specific Integrated Circuit (ASIC)solution 

combining 10Gbps iSCSI, TCP/IP offload, embedded processors and a storage virtualization 

firmware stack controlled by firmware loaded into the on-board flash memory. The controller is 

housed in a 19-inch 3U rugged hardware enclosure holding up to 15 internal Serial ATA (SATA) 

drives, up to 512MB of system memory and up to 4GB of cache buffer memory.  Host connectors 

for each model are as follows: 

- DSN-3200 provides eight 1GbE RJ-45 host connectors accessed via the back panel 

- DSN-3400 provides a single 10GbE XFP-transceiver interface (transceiver sold separately) 

accessed via the back panel. 

The xStack Storage Array’s back panel also has a 10/100 Mbps management port and an RS-232-C 

DB9 diagnostic/console port. 

Complete configuration and management are available through the intuitive, GUI-based Web 

Manager interface. A variety of network configurations are easily established using the xStack 

Storage Array’s volume management, initiator, target, network portal, and Link Aggregation 

Group (LAG) features. In addition, the xStack Storage Array features Secure Sockets Layer (SSL), 

default task priority, cache, TCP/IP, spare count, and battery policy settings for advanced users.
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1.1 Models 

The xStack Storage DSN-3000 series is available in a standard 19-inch 3U rack-mount chassis with 

15 hot-swappable drive bays.  The models vary according to the number, speed, and type of host 

network connections.   

Table 1-1  xStack Storage Array Models 

Model Description 

DSN-3200 Maximum number of host network iSCSI connections: Eight RJ-45 ports 

Speed: 1 Gigabit Ethernet (1 GbE) 

Maximum number of internal SATA drives: 15 

Maximum amount of system memory: 512MB 

Maximum amount of cache buffer memory: 4GB 

DSN-3400 Maximum number of host network iSCSI connections: One XFP transceiver host network connection 

Speed: 10 GbE 

Maximum number of internal SATA drives: 15 

Maximum amount of system memory: 512MB 

Maximum amount of cache buffer memory: 4GB 
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1.2 Benefits and Features 

� High-performance, low-latency iSCSI storage system, with a highly integrated, reliable, 

multifunction ASIC for fully featured, integrated storage virtualization. 

� Modular design with up to 15 SATA disk drives. 

� 1 GbE and 10 GbE models provide an easy transition to faster Ethernet connectivity. 

� Eight copper 1Gb (802.3ab) Ethernet network ports on the DSN-3200 

� One XFP 10Gb Ethernet port on the DSN-3400. (XFP transceiver sold separately) 

� One DB9 RS-232-C diagnostic port 

� Easy setup and configuration – can be placed anywhere on a 10BaseT, 100BaseT, or Gigabit 

Ethernet network for improved access to critical information. 

� Out-of-band management via a direct connection or the Web. Communication via the 

management port is encrypted using SSL, without requiring configuration by the user. 

� Delivers Ethernet economics to storage for lower total cost of ownership and rapid 

deployment using known and trusted technologies. 

� Proven transport infrastructure for increased reliability, investment protection, and reduced 

training costs. 

� Scalability over long distances - ideal for remote data replication and disaster recovery. 

� One 760W 3U n+1 auto-switching universal power supply for high availability 

� Three hot-swappable cooling fans 

� Supports Self-Monitoring Analysis and Reporting Technology (S.M.A.R.T.), a technology 

designed to monitor the reliability of hard drives. 

� Battery pack preserves the contents of the buffer cache in the event of a power failure 

(contents will be backed up for approximately 72 hours) 
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1.3 System Overview 

Figure 1-1 shows a typical Storage Area Network (SAN) configuration in which xStack Storage 

Array can be used. The Storage Area Network portion of this diagram is a private high-speed 

Ethernet network that is dedicated to the exchange of data between the network servers and the 

xStack Storage Array.  The high bandwidth used by the servers exchanging data with the xStack 

Storage Array can easily consume high bandwidth on the LAN (Local Area Network) where users 

PCs are attached. Creating a separate network to isolate this traffic avoids bogging down the 

customer’s existing LAN and helps improve security. 

 

Figure 1-1 xStack Storage Array System Diagram 
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Chapter 2 Identifying Hardware Components 

This chapter describes the xStack Storage Array’s hardware components.  

2.1 Front Panel Components 

The following sections describe the hardware components on the front of the xStack Storage 
Array enclosure.  Figure 2-1 shows the removable front bezel along with the drive bays and 
major components. 

 

 

Figure 2-1 Front View of the xStack DSN-3000 Series Enclosure 

 

 

When installed, the front bezel uses pipes to pass light from the LEDs behind 

it to the front for viewing.  The bezel itself is passive and has no active LEDs. 
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2.1.1 LEDs 

Figure 2-1 reveals several LEDs that provide useful information about the state of the xStack 

Storage Array.  The Power LED illuminates when the system is powered.  The bicolor Boot and 

Fault LED will remain clear during bootup and then green if booting is successful.  If the boot 

process is unsuccessful, or a system fault occurs, then it will turn red. 

Each of the fifteen drive bays has two LEDs associated with it, a bicolor drive activity and 

fault LED and a drive power LED.  Table 2-1 describes the front panel LEDs and their functions. 

Table 2-1 Front Panel LED indicators on the DSN-3000 series enclosure 

LED Color Meaning 

Power Green ON Power is applied to the system 

Green ON Successful boot.  No errors encountered. Boot and Fault 

Red ON Remains clear during boot process.  If red after boot process 
completed, then an error has been encountered.  Please see 
management GUI for more information. 

Drive Power Blue ON Drive is powered and operational. 

Green Blinking Data being transmitted or received from corresponding SATA drive. Drive Activity and 
Fault 

Red ON Drive has experienced a fault and is offline 

2.1.2 Key Lock and Latches 

Figure 2-1 shows the xStack Storage Array’s front bezel with key lock and two latches.  This 

bezel can be locked in place to protect the system from unauthorized drive access and 

removal. 

Bezel Removal: Simply press inwards (as the arrows reveal) on the two latches shown in Figure 

2-1.  The bezel will come off easily providing access to the drive bays behind it.  If the key 

lock is in the locked position, then the latches cannot be pressed inwards. 

Bezel Installation: Align the bezel in front of the chassis and push forward.  The latches are 

spring-loaded and will lock into place.  If you wish, you can use the key lock to prevent drive 

access by turning it to the locked position. 
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2.1.3 Drive Bays 

Figure 2-1 illustrates the fifteen hot-swappable drive bays and their numbering scheme from 

left to right (0 through 14). 

2.1.3.1 Drive and Tray Removal 

A drive/tray assembly can be removed by pressing upwards on the green latch found on the 

tray and removing it with the handle as shown in Figure 2-2 and Figure 2-3. 

 

Figure 2-2 Drive and Tray Removal 

 

Figure 2-3 Remove Drive/Tray 
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Removal of a populated drive/tray assembly can have unforeseen effects 

including the loss of all data in a volume.  A drive can be part of a volume 

that may or may not be redundant.  Before removing a drive from an 

operating xStack Storage Array, make sure it is the correct one. 
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2.1.3.2 Drive and Tray Installation 

A drive/tray assembly can be installed by inserting the drive/tray assembly into the open 

drive bay as shown in Figure 2-4.  Push the tray at the point indicated in Step 2 of Figure 2-5 

and push until it is seated firmly within the bay.  As you press, you will see the tray handle 

begin to move inwards as the locking mechanism enters the locking slot.  When you see this, 

then you must push the tray handle inwards as shown in Figure 2-6 until you hear the green 

locking mechanism click. 

 

Figure 2-4 Drive/Tray Installation 

 

Figure 2-5 Press Here Until You See the Lever Move Inwards 
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Figure 2-6 Press Lever Inwards Until it Locks 
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2.1.4 Front Vents 

The enclosure that houses the xStack Storage Array contains a set of three hot-swappable fans 

located in the mid-section of the chassis drawing air into vents in the front of the unit, cooling 

the hard drive array and other components.  This air exits the chassis through a grill located at 

the rear of the chassis.  It is advised that the unit only be operated with the top cover in 

place.  When installing the xStack Storage Array, please be sure these vents are not blocked. 

 

 

A fully loaded array with all drive bays filled can generate a significant 

amount of heat.  Please be sure the cover is in place to provide the forced 

air flow required for proper cooling. 

 

 

2.2 Back Panel Components 

The following sections describe the hardware components on the rear of the xStack Storage 
Array’s enclosure.  Figure 2-7 shows the major components. 

 

 

Figure 2-7 Rear View of the xStack Storage DSN-3200 Enclosure 
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2.2.1 Switches 

The rear panel of the xStack Storage unit enclosure has two switches as shown in Figure 2-8. 

Table 2-2 identifies the switches and their function. 

 

Figure 2-8 Power and Reset Switches 

Table 2-2 Power and Reset Switches Function 

Switch Description 

Power Applies power to the xStack Storage Array. Pressing this switch for longer than 3 seconds removes power 
from the xStack Storage Array and turns off the unit. 

Reset Resets the xStack Storage Array. 
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2.2.2 External Interfaces 

Figure 2-7 shows an area labeled “External Interfaces” where the external ports of the DSN-

3000 Series are found. 

2.2.2.1 DSN-3200 External Interfaces 

The back of the xStack Storage DSN-3200 enclosure provide the following external interfaces: 

� Eight (8) 1GbE (1 Gigabit Ethernet) RJ-45 host network connections  

� One DB9 RS-232-C diagnostic port  

� One RJ-45 Fast Ethernet management port 

Figure 2-9 shows the hardware components on the back of the xStack Storage DSN-3200 

enclosure 

 

Figure 2-9 External Interfaces on the xStack Storage DSN-3200 Enclosure 
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2.2.2.2 DSN-3200 LEDs 

Each RJ-45 host network connection on the back of the xStack Storage DSN-3200 enclosure has 

two bicolor light-emitting diode (LED) indicators that show the activity and speed for that 

port. Table 2-3 describes the host network connection LED indicators on the back of the 

xStack Storage DSN-3200 enclosure. 

Table 2-3 Host Network Connection LED Indicators on the xStack DSN-3200 Enclosure 

LED Color Description 

Green Data is being transmitted on the RJ-45 port. RJ-45 Port 
Activity 

Yellow Data is being received on the RJ-45 port. 

OFF Data is being sent or received at 10 Mbps. 

Green Data is being sent or received at 100 Mbps. 

RJ-45 Port 
Speed 

Yellow Data is being sent or received at 1 Gbps. 

In addition, the management port has two bicolor LED indicators that show the activity/link 

and speed for this port. Table 2-4 describes the management port LEDs and Figure 2-9 shows 

their location. 

Table 2-4 Management Port LED Indicators on the xStack Storage DSN-3200 Enclosure 

LED Color Meaning 

Green ON Link is operational. 

Green Blinking Data is being transmitted or received on the RJ-45 port. 

Yellow OFF Connection has been established at 10 Mbps. 

Activity/Link 

Yellow ON Connection has been established at 100 Mbps. 

OFF Data is being sent or received at 10 Mbps. Port Speed 

Yellow Data is being sent or received at 100 Mbps. 
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2.2.2.3 DSN-3400 External Interfaces 

The back of the xStack DSN-3400 enclosure provides the following external interfaces: 

� A single 10 GbE XFP transceiver host network connection 

o (optical or copper depending on what interface you install) 

� One DB9 RS-232-C diagnostic port  

� One RJ-45 Fast Ethernet management port 

Figure 2-10 shows the hardware components on the back of the xStack DSN-3400. 

 

Figure 2-10  External Interfaces on the xStack DSN-3400 Enclosure 

2.2.2.4 DSN-3400 LEDs 

Two LEDs next to the XFP connector show transmit (Tx) and receive (Rx) activity on the host 

network interface. Table 2-5 describes the Tx and Rx LED indicators on the back of the xStack 

DSN-3400 enclosure. 

Table 2-5 Host Network Connection LED Indicators on the xStack DSN-3400 Enclosure 

LED Color Description 

OFF There is no transmit activity. Tx Link 

Blinks Green There is transmit activity from the xStack DSN-3400. 

OFF There is no receive activity. 

Solid Yellow A 10GbE connection has been established. 

Rx Link 

Blinks Yellow There is receive activity with the xStack DSN-3400. 
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In addition, the management port has two bicolor LED indicators that show the activity/link 

and speed for this port. Table 2-6 describes the management port LEDs and Figure 2-10 shows 

their location. 

Table 2-6 Management Port LED Indicators on the xStack DSN-3400 Enclosure 

LED Color Meaning 

Green ON Link is operational. 

Green Blinking Data is being transmitted or received on the RJ-45 port. 

Yellow OFF Connection has been established at 10 Mbps. 

Activity/Link 

Yellow ON Connection has been established at 100 Mbps. 

OFF Data is being sent or received at 10 Mbps. Port Speed 

Yellow Data is being sent or received at 100 Mbps. 

2.2.3 Rear Vents 

Figure 2-7 shows air vents that allow the exit of air through the rear of the chassis.  Please be 

sure these vents are not blocked. 
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Chapter 3 Installing the xStack Storage Array 

This chapter describes how to install the xStack Storage Array. 

3.1 Site Considerations 

The site where you install the xStack Storage Array can affect its performance, Please observe the 

following guidelines when setting up the xStack Storage Array. 

� Install the xStack Storage Array on a sturdy, level surface that can support the unit. A fully 

populated xStack Storage unit weighs approximately 75 lbs. (33 kg.). 

� The power outlet should be within six feet (1.82 meters) of the xStack Storage Array. 

� For the xStack Storage Array to perform at optimal levels there must be adequate heat 

dissipation and ventilation around the unit to avoid overheating. 

– Leave at least six inches (152.3 mm) of space at the front and back of the xStack Storage 

Array for ventilation. 

– Do not locate the xStack Storage Array next to, on top off, or below any device that 

generates a significant amount of heat or will block the fee flow of air through the 

ventilation slots on the xStack Storage Array. 

� Install the xStack Storage Array in a fairly cool and dry location for the acceptable 

temperature and humidity ranges. 

� Install the xStack Storage Array in a site free from strong electromagnetic field generators 

(such as motors), vibration, dust, and direct exposure to sunlight. 

For rack installation, the following additional considerations must be observed: 

� The xStack Storage Array can be mounted in a standard 19-inch rack. The rack-mounting 

hardware must be carefully selected to properly support the equipment. Follow the 

instructions in the documentation for the rack. 

� The operating ambient temperature of rack-mounted equipment must not exceed the 

maximum rated ambient temperature of 104 degrees F (70 degrees C). 

� The air flow clearances specified in this guide must be maintained within the rack. 

� The AC supply circuit for rack-mounted equipment must be capable of supplying the total 

current specified on all the labels of the rack-mounted equipment. 

� All AC power supply connections must be properly earthed. To ensure the integrity of the 

earth connection, special attention must be given to connections that are not directly 

connected to the branch circuit (for example, power strips). 
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3.2 Safety Considerations 

Observe the following guidelines to ensure safety: 

� Do not wear loose clothing that could get caught in the chassis mounting hardware. 

� Wear safety glasses when working under conditions that are hazardous to your eyes. 

� Do not perform any action that creates a potential hazard to people or makes the rack or 

equipment unsafe. 

� Do not work on the equipment or disconnect cables during a thunderstorm, when wearing a 

wool sweater or other heavy wool clothing, or when power is applied. 

� Disconnect all power before installation and before connecting or disconnecting cables. 

� Avoid hazards such as moist floor and ungrounded power-extension cables. 

� To avoid damage to the xStack Storage Array due to Electrostatic discharge (ESD), wear an 

ESD-preventive wrist strap. If no wrist strap is available, ground yourself by touching the 

metal part of the chassis. Connect the clip to an unpainted surface of the chassis frame to 

safely channel unwanted ESD voltages to ground. 

3.3 Unpacking the xStack Storage Array  

After receiving the xStack Storage Array, perform the following steps to ensure that it and other 

contents arrived safely. 

To unpack the xStack Storage Array: 

1. Inspect the outer shipping container for any damage that may have occurred in shipping. 

Report any sign of damage to the appropriate shipping agency. 

2. Remove the xStack Storage Array and cables from the shipping container. 

3. Save the shipping container, foam, and antistatic bags in case you have to return the xStack 

Storage Array. Returning the xStack Storage unit in any other container is not advised. 

4. Be sure the following parts are included: 

– xStack Storage Array 

– Three power cords 

– Console cable (straight-through female DB9 to female DB9)  

– Rackmount rail kit 

– CD including this User Guide 

5. Inspect the xStack Storage Array thoroughly. If you see any signs of damage, notify a sales 

representative and/or the shipping agency. 
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3.4 Items Supplied by the User 

Table 3-1 lists the additional items that you must supply to perform the xStack Storage Array 

installation. All users must provide the items in the first row of Table 3-1. Thereafter, the 

additional items required for installation depend on the user category into which you fit. 

Table 3-1 User-Supplied Items to Perform the xStack Storage Installation 

User Category User-Supplied Items 

All xStack Storage 
Users 

� One or more computers with Network Interface Cards (NICs) that will act as the iSCSI initiator(s). 
This is typically the user’s server(s). Each iSCSI initiator must be given an iSCSI initiator node 
name. (See Note 1) 

� A PC with a NIC, a fixed IP address, and Internet access that will act as the management console. 
(See Note 1) 

� One or more available AC outlets not controlled by a wall switch. 

� Optional: An Ethernet switch and Ethernet cable. If you want to use the xStack Storage Array’s Link 
Aggregation feature, the switch must support LAGs. 

xStack DSN-3200 
Users 

� A static IP address for each xStack Storage host connection RJ-45 data port that will connect to 
your SAN.  

� An Ethernet cable for each xStack Storage host connection RJ-45 data port that will connect to 
your SAN (the xStack Storage auto-senses the cable type used). 

xStack DSN-3400 
Users 

� A static IP address for the host network connection.  

� Either a single mode or multimode XFP optical cable or a copper Ethernet cable, and the 
appropriate XFP module to connect the host network connection to your SAN. 

Rack-Mount Users � A standard NEMA-compliant 19-inch rack. 

� Mounting hardware. 

Note 1: For convenience, one PC with three installed NICs can be used instead of separate PCs. In this configuration, one NIC 
connects to the xStack Storage management port, a second NIC connects to the Internet, and a third NIC is used with the iSCSI 
initiator. 
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3.5 Installing the xStack Storage Array without a Rack 

When installing the xStack Storage Array on a desktop or shelf, allow enough ventilation space 

between the xStack Storage unit and any other objects in the vicinity. In particular, be sure not to 

block the air vents on the front and back of the xStack Storage Array enclosure. Install the cables 

and power cord according to the procedures in the following sections. 

3.6 Installing the xStack Storage Array in a Rack 

The xStack Storage Array can be mounted in a standard 19-inch rack. Use the following procedure, 

along with the documentation for the rack, to install the xStack Storage unit in a rack. 

 

 

The rack cabinet must provide sufficient airflow to the front and back of the 

xStack Storage unit to maintain correct cooling. It must include ventilation 

sufficient to exhaust the heat generated by equipment installed in the rack. 

 

1. Be sure the xStack Storage Array is turned off and its three power cords are not attached to 

the unit. 

2. Attach the mounting hardware to the left and right sides of the xStack Storage Array. Refer to 

the documentation for your mounting hardware and rack. 

3. With the assistance of another person, hold the xStack Storage unit in place in the rack and 

secure with the mounting hardware. Refer to the documentation for your mounting hardware 

and rack. 

4. Install the cables and power cords according to the procedures in the following sections. 
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3.7 Connecting to the xStack Storage DSN-3200 Host Network Connection Ports 

The DSN-3200 host network connections consist of eight RJ-45 data ports. These ports connect to 

your SAN using either a straight-through or cross-over RJ-45 Ethernet cable (the xStack Storage 

Array auto-senses the type of cable used). You will need one cable for each RJ-45 data port you 

want to connect to your SAN. 

To connect the DSN-3200 RJ-45 host network connections to your SAN, use the following 

procedure: 

1. Attach either end of an Ethernet cable to host network connection port 0 on the xStack 

Storage unit’s back panel 

2. To connect additional DSN-3200 RJ-45 host network connections to your SAN, repeat step 1 

using another Ethernet cable and the next available xStack Storage port in sequence (port 1, 

then port 2, and so on). Do not skip ports when making these connections. 

3.8 Connecting to the xStack Storage DSN-3400 Host Network Connection Port 

The DSN-3400 host network connection consists of a single 10 GbE host network XFP transceiver 

interface. The XFP module can consist of either optical or copper connectivity depending on the 

XFP module you install.  An optical solution connects to your SAN using a single mode or 

multimode XFP optical cable.  A copper solution attaches to your SAN with a special CX4 cable. 

(XFP transceiver sold separately) 

To connect the DSN-3400 host network connection port to your SAN, use the following procedure. 

1. If an optical XFP module has been installed, then connect one end of a single mode or 

multimode optical cable to the xStack Storage optical host network connection port.  If a 

copper CX4 XFP module has been installed, then connect one end of a copper CX4 cable to 

your xStack Storage host network connection port. 

2. Connect the other end of the cable to your SAN. 
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3.9 Connecting to the xStack Storage Management Port 

Connecting a PC to the xStack Storage management port lets you configure and manage the xStack 

Storage Array. This procedure requires a PC with an installed NIC and an appropriately configured 

Ethernet cable.  

� To connect the PC directly to the xStack Storage management port, use a cross-over cable. 

� To connect the PC to the xStack Storage Array using a hub or switch, use a straight-through 

cable. 

To connect to the xStack Storage management port, use the following procedure. 

1. Connect either end of an Ethernet cable to a NIC installed in the PC that will be used to manage and 

monitor the xStack Storage unit. 

2. Connect the other end of the cable into the xStack Storage Mgmt Ethernet port. Facing the back of 

the xStack Storage unit, the management port is the rightmost RJ-45 connector: 

– To view this port on the xStack DSN-3200, see Figure 2-9 on page 23. 

– To view this port on the xStack DSN-3400, see Error! Reference source not found. on 

page 25. 

 

 

If you want to configure the xStack Storage Array for email alert 

notifications, be sure the management port can communicate via Ethernet 

with your mail server. 

 

 

xStack Storage management and data activities must be separate. This 

means you cannot connect the same NIC to the management and host 

network connection ports. Rather, one NIC must connect to the management 

port and a different NIC, either in the same PC or a different PC, must 

connect to the host network connection port(s). 
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3.10 Connecting the Battery Pack 

The xStack Storage Array comes equipped with a battery pack to provide back up of the buffer 

cache contents (See Figure 3-1). Since write-back caching is always enabled on the xStack Storage 

Array, we recommend you have a battery installed at all times.  The battery is attached to the 

controller board through a 3-pin connector at J-35. 

 

Figure 3-1 Battery Pack Installed on xStack Controller 
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3.11 Connecting the Power Cords 

The receptacles for connecting the xStack Storage Array’s three power cords appears on the back 

of the unit as seen in Figure 3-2. To connect a power cord for each of the power supplies three 

redundant power modules, use the following procedure. 

1. Plug the female end of the power cord into one of the three 3-pronged power connectors on 

the back of the xStack Storage unit. 

2. Plug the other end of the power cord into a working AC outlet that is not controlled by a wall 

outlet. 

3. Repeat steps 1 and 2 for the remaining two power cords. 

 

 

                 Figure 3-2 Power Supply 
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3.12 Booting the xStack Storage Array  

To power on the xStack Storage Array, press the power switch on the rear panel as seen in Figure 

3-3. When the xStack Storage unit powers on, the following actions occur: 

� The front panel Power LED goes ON. 

� The xStack Storage unit runs its startup process, which takes from 4 to 5 minutes to complete. 

� The front panel Link Status LEDs for the SATA drive LEDs may flash. 

� When the Boot and Fault Ready LED turns green the xStack Storage unit is ready for use. 

When power is applied to the xStack Storage Array for the first time with a Web browser attached 

to the unit’s management port, the “Out-of-Box Experience” (OOBE) setup wizard is launched, 

allowing you to specify initial settings. Thereafter, each subsequent time you start the xStack 

Storage Array, the unit uses the initial settings along with its factory-default configuration 

settings. If necessary, you can use the xStack Storage Web Manager Interface to change the initial 

and factory-default settings to suit you requirements. 

 

 

 

Figure 3-3 Power-On Switch and Reset Switch Located on Rear of Enclosure
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Chapter 4 Starting the xStack Storage Array for the First Time 

The xStack Storage Array is designed with simplicity and ease-of-use in mind for new users.  

Towards that end, the xStack Storage Array comes with an "Out-Of-Box Experience" (OOBE) setup 

wizard that lets you expedite the unit’s configuration.  After the OOBE setup wizard is 

completed, the xStack Storage Array boots up using the settings you configured in the OOBE 

setup wizard.  Thereafter, you can use the procedures in Chapter 5 to change these settings if 

necessary. 

Before you start the OOBE: 

1. Connect a PC with an installed Web browser.  

 

 

The IP address for the NIC in the management PC must be on the same IP 

subnet (192.168.1.x) as the management port. 

2. Start a Web browser on the PC connected to the xStack Storage Array’s management port. 

3. In the browser’s address bar, type the following default IP address for the management 

console and press the Enter key: 

192.168.1.1 

4. Start the xStack Storage Array and proceed to Section 4.1. 

4.1 Initial Startup and Welcome 

When you start the xStack Storage Array for the first time, the system goes through its Power On 

Self Test, and then displays the Welcome screen shown in Figure 4-1. Click the Start button in 

the Welcome screen to continue and proceed to Section 4.2. 

 

Figure 4-1 Welcome Screen 
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4.2 Entering Initial Management Port Settings 

After you click the Next button in the Welcome screen, the Management Port screen in Figure 

4-2 appears. This screen lets you specify the settings that client computers will use to access the 

xStack Storage Array management console. The values you enter must be compatible with your 

local network and accessible to the client computers that will be accessing the xStack Storage 

Array management console. Complete the fields on this screen (see Table 4-1), then click the 

Next button when finished.  

 

 

If you need to change these initial settings at a later time, use the 

procedures described in Chapter 5. 

 

Figure 4-2 Management Port Screen 

Table 4-1. Initial Management Port Settings 

Setting Description 

IP Address Enter the IP address that client computers must use to access the xStack Storage 
Array’s management console. Make note of  the new IP address for reference purposes. 

Subnet Enter the subnet mask that client computers must use to access the xStack Storage 
Array’s management console. The NIC in the management PC will be modified to use 
the same subnet when you finish the OOBE setup wizard. 

Default Gateway Enter the default gateway that client computers must use to access the xStack Storage 
Array’s management console. 

Host name The xStack Storage Array is assigned a default host name. If desired, you can change 
this name to one that is meaningful to you. 
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4.3 Entering Administrator Account Password 

After you click the Next button from the Management Port screen, the Administrator Account 

screen in Figure 4-3 appears. This screen lets you specify the administrator password that will be 

required to log in to the management console. Complete the fields on this screen (see Table 4-2), 

then click the Next button when finished. 

 

 

If you need to change these initial settings at a later time, use the 

procedures described in Chapter 5. 

 

Figure 4-3 Administrator Account Screen 

Table 4-2 Administrator Account Settings 

Setting Description 

Password Enter the password for the administrator account. This case-sensitive password must be 
specified when logging in to the management console. For security, each typed 
character appears as an asterisk (*). 

Re-type Password Retype the same case-sensitive password typed in the Password field. For security, 
each typed character appears as an asterisk (*). 
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Firmware 1.4.0.27 and later will not allow the primary admin account 

“admin” to be deleted.  For security, please be sure to change the default 

admin account’s password. 

 

4.4 Entering the System Date and Time 

After you click the Next button from the Administrator Account screen, the Date/Time screen in 

Figure 4-4 appears. This screen lets you specify the system date and time and time zone. 

Complete the fields on this screen (see Table 4-3), then click the Next button when finished. 

 

 

If you need to change these initial settings at a later time, use the 

procedures described in Chapter 5. 

 

Figure 4-4 Date/Time Screen 

Table 4-3 Date/Time Settings 

Setting Description 

Date and Time Use the controls to the right of this field to select the appropriate system date and time, 
or click the calendar icon and select a date from the popup calendar. 

Time Zone Select the appropriate timezone from the drop-down list. 
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4.5 Setting Up Email Notifications 

After you click the Next button from the Date/Time screen, the Email Notification screen in 

Figure 4-5 appears. This screen lets you enable and configure the xStack Storage Array to send 

notifications by email when a serious event occurs, such as if a S.M.A.R.T. threshold has been 

exceeded. To use this feature, the xStack Storage Array management port must be able to 

communicate with your LAN’s Simple Mail Transfer Protocol (SMTP) server. Complete the fields 

on this screen (see Table 4-4), then click the Next button when finished. 

 

 

To receive email notifications, be sure that your SMTP server is set up 

correctly and that you are able to use it for your normal emails. 

 

 

If you need to change these initial settings at a later time, use the 

procedure described in Chapter 5. 

 

Figure 4-5 Email Notification Screen 
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Table 4-4 Email Notification Settings 

Setting Description 

Enable Email Support Click this option to enable email notifications from the xStack Storage Array. 

SMTP Server IP Address Enter an IP address that identifies the xStack Storage Array as the source of the email. 

Port Number Enter the SMTP port on which the mail server will be listening for email alerts from the 
xStack Storage Array (default is 25). 

From Enter the email address of a user. Each email sent by the xStack Storage Array will be 
identified as being sent from this user. 

To Enter the email address where notifications are to be sent. This can be an individual 
email address or a distribution list. 

4.6 Completing the OOBE Setup Wizard 

After you click the Next button from the Email Notification screen, a screen similar to the one in 

Figure 4-6 appears, with a summary of the initial settings you specified in the OOBE setup wizard. 

Review the settings to ensure they are correct. If you need to change a setting, click the 

Previous button until you return to the appropriate screen, change the setting, and then click 

the Next button until you return to the screen below. 

 

Figure 4-6 Screen Summarizing Initial Settings 
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When you are certain that the initial settings are correct, click the Finish button. A screen 

similar to the one in Figure 4-7 appears and the xStack Storage Array restarts using the initial 

settings you specified. If you changed the IP address for the management port, the screen alerts 

you to change the settings on your management PC, so you can access the xStack Storage Array 

console. 

 

Figure 4-7 Restart Message 
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Chapter 5 Configuring the xStack Storage Array 

This chapter describes how to use the Web manager interface to change the xStack Storage 

Array’s initial settings, which you specified in the OOBE setup wizard, and factory-default 

settings. Web Manager is a Java-based graphical point-and-click Web interface that can be 

accessed from any PC with Internet access. You can also access the Web Manager using a PC 

connected directly to the xStack Storage Array management port (see Section 3.9). 

The topics in this chapter include: 

� Section 5.1, Launching the xStack Storage Management Console on page 46 

� Section 5.2, Understanding the Main Screen on page 49 

� Section 5.3, Managing User Accounts on page 55 

� Section 5.4, Managing the xStack Storage Array on page 57 

� Section 5.5, Changing Initial Configuration Settings on page 96 

� Section 5.6, Managing xStack Storage Array Configurations on page 99 

� Section 5.7, Restarting the xStack Storage Array on page 101 

� Section 5.8, Shutting Down the Management Console on page 102 

� Section 5.9, Shutting Down the xStack Storage Array on page 102 
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5.1 Launching the xStack Storage Management Console 

The following procedure describes how to launch the xStack Storage Array’s management 

console. This procedure assumes that: 

� The xStack Storage Array is powered-up. 

� A PC with an installed Web browser and Java v1.4.2 is connected to the management port. If 

the PC needs Java v1.4.2, you can download it from the xStack Storage Array Login screen. 

For this reason, the management PC should have Internet access. 

� The OOBE has already been performed (refer to 4.1). 

� The IP address on the PC's NIC is on the same IP subnetwork (e.g., 192.168.1.x) as the 

management port. (If you changed the IP address since the last startup, please adjust your 

PC’s configuration accordingly.) 

To launch the management console: 

1. Start a Web browser on the PC connected to the xStack Storage Array’s management port. 

2. In the browser’s address bar, type the IP address you specified during the OOBE (see Chapter 

4) and press the Enter key. The default IP address is: 

192.168.1.1 

If the xStack Storage Array is still in its boot-up process and not fully operational, then a 

screen similar to Figure 5-1 appears that monitors the process of the startup.  

When the array has booted, then the browser connects to the xStack Storage Array and a 

Login screen appears. (See Figure 5-2) 

 

 

If you receive an IP address not found message, be sure you entered the 

appropriate IP address. Then try to log in to the xStack Storage Array again. 

 If your browser displays an xStack Storage page instead of the Login screen, 

read the directions. If the page indicates that your computer does not have 

Java installed, click where requested to download and install Java and Java 

Web Start. When this process completes, the Login screen appears. 

3. In the appropriate text boxes, enter the username and password as configured in the OOBE 

setup wizard. The default username is admin and the default password is admin. 

 

 

If desired, you can click the More button to view the IP address you will be 

connecting to and change it if necessary. 

4. Click the OK button. A screen appears with a progress bar as the connection is made to the 

xStack Storage Array. When the connection is made, the main screen appears (see Figure 

5-3). 
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Figure 5-1 xStack Storage Array Startup Screen 

 

 

Figure 5-2 xStack Storage Log in Screen 
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Figure 5-3 xStack Storage Management Console Main Screen 
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5.2 Understanding the Main Screen 

Figure 5-4 shows the areas of the xStack Storage Array’s management console main screen. 

 

 

 

Figure 5-4 Parts of the xStack Storage Management Console Main Screen  
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5.2.1 Menu / Tool Bar Area 

The Menu/Tool Bar Area appears at the top of the xStack Storage management console window. 

This area contains the following components (Figure 5-5): 

� Title bar. The title bar shows the name of the application. On the right side of the title bar 

are the standard Windows buttons for minimizing, maximizing, and closing the xStack Storage 

management console application. 

� Menu bar. The menu bar is located below the title bar. The menu bar contains the menus 

you can select to perform a range of storage tasks. The xStack Storage management console 

provides the following menus: 

– File 

– View 

– Storage  

– Network 

– Help 

Depending on the activity you are performing, some menus may be gray and unavailable.  

� Tool bar. The tool bar is located below the menu bar. The tool bar provides convenient 

shortcuts for menu options and other operations. The tools that appear on the tool bar vary, 

depending on the task you are performing. 

 

Figure 5-5 Menu/Tool Bar Area 
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5.2.2 Resources Pane 

The resources pane shows the Physical Resources tab or Logical Resources tab. Only one tab 

can be active at a time. To switch between them, click the tab name. These tabs work the same 

way as in Windows Explorer. A plus sign (+) means an item contains subitems. To see the 

subitems, double-click the item or click the plus sign next to it. When an item is expanded, a 

minus sign (-) replaces the plus sign. Clicking the minus sign collapses the item.  

In this Guide, you will see references to the “active tab.” The active tab is the tab that is on top 

(in front) of the other tab. Only one tab can be active at a time. To switch between the Physical 

Resources tab and the Logical Resources tab, click the tab name. (See Figure 5-6) 

     

Example of Physical Resources Tab             Example of Logical Resources Tab 

Figure 5-6 Resources Pane 
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5.2.2.1 Physical Resources Tab 

The Physical Resources tab contains the following physical resources: 

� The xStack Storage unit ( ). 

� The physical drives attached to the xStack Storage Array ( ). 

� The Ethernet ports on the xStack Storage Array ( ). To enhance viewing, the port icons are 

color coded (black = link is down, green = link is up). 

5.2.2.2 Logical Resources Tab 

The Logical Resources tab shows the following logical resources: 

� Unusable Collection ( ). Shows drives that have been pulled out of the xStack Storage 

Array. Two types of drives appear in the Unusable Collection:   

– Drives not available for use because they have failed and have not been removed from 

the enclosure. 

– Drives that were found to be used previously by an xStack Storage Array. 

Initializing a drive in the Unusable Collection moves it to the Available Pool, where volumes 

can be rebuilt if necessary. 

� Blade A Base Pool ( ). Shows drives ( ) currently being used to hold volumes ( ) or 

ready to be used to hold volume data.  

� Available Pool ( ). Shows the available drives ( ) that can be added to the storage pool. 

Initially, all drives appear here until they are needed for use in a volume or dragged and 

dropped by the administrator into the Blade A Base Pool. A spare drive is normally kept here 

to keep it available for use should any other drive fail. 

� Target Resources. Shows the network entities ( ) and LAGs ( ). 

� Initiator Resources. Shows the iSCSI initiators ( ) that have been created. 

 

 

If a volume is reduced (for example, if a physical drive fails), the firmware 

will automatically move a drive from the Available Pool to the Blade A Base 

Pool if there is insufficient space to otherwise start a rebuild operation for 

that volume. 
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5.2.3 Main Display Area 

Some items in the Physical Resources and Logical Resources tabs have storage or system 
information associated with them. When you click such an item, the storage or system 
information is displayed in one or more “tabbed” screens in the main display area. The tabbed 
screens resemble index cards. If you click the top xStack Storage item in the left pane of either 
the Physical Resources tab, for example, four tabs appear in the main display area (see Figure 
5-7). You can then click the tab to view the information on it. 

For more information about the screens that can appear in the main display area, refer to 

Chapter 6. 

 

Figure 5-7 Main Display Area 
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5.2.4 Footer 

The footer appears at the bottom of the xStack Storage management console window. The footer 

shows status information when appropriate. If you select Blade A Base Pool in the Logical 

Resources tab, for example, the words Blade A Base Pool appear in the footer (see Figure 5-8). 

 

Figure 5-8 Example of Message in the Footer 
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5.3 Managing User Accounts 

The xStack Storage Array comes with a single user account called admin. A user account must be 

set up for each additional user who will be authorized to access the management console. The 

user account consists of a unique username and password, and permissions for managing storage 

and/or adding or editing user accounts.  

By default, the admin user can manage storage and add and edit user accounts. When the admin 

user sets up a user account, he specifies storage and user account permissions for each user. The 

permissions work independently, so the admin could: 

� Let a user manage storage, without being able to add or edit user accounts. 

� Let a user add or edit other user accounts, without being able to manage storage. 

� Limit a user to read-only permissions that let the user view management console screens, 

without being able to manage storage or add/edit user accounts. 

 

 

The admin account cannot be deleted in firmware version 1.4.0.27 and 

above.  For security, please be sure to change the password for this account.  

However, if you lose the password for the admin account, you may use the 

diagnostic port to reset the password (see Appendix E). 

5.3.1 Setting Up User Accounts 

To set up user accounts, use the following procedure. 

1. Be sure the Physical Resources tab is the active tab. 

2. On the View menu, click User Accounts. The User Accounts screen appears, with a list of the 

user accounts that have been defined (see Figure 5-9). 

 

Figure 5-9 User Accounts Screen 
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3. Click the Add User button. The Add New User dialog box appears (see Figure 5-10). 

 

Figure 5-10 Add New User Dialog Box 

4. Complete the fields in the dialog box (see Table 5-1). 

5. Click OK. The user you defined appears in the User Accounts screen. 

6. Click the Close button to exit the User Accounts screen. 

Table 5-1 Add New User Dialog Box Settings 

Setting Description 

Username Enter the name of the user whose account you are creating. 

Password Enter the password for this user account. The user must specify this case-sensitive 
password when logging in to the management console. For security, each typed 
character appears as an asterisk (*). 

Confirm password Retype the same case-sensitive password typed in the Password field. For security, 
each typed character appears as an asterisk (*). 

Allow to manage storage Check this option to let this user manage storage on the xStack Storage Array. 

Allow to manage user accounts Check this option to let this user define and modify user accounts. 

 

 

If you leave Allow to manage storage and Allow to manage user accounts 

unchecked, the user will be able to view management console screens, but 

will not be able to change storage settings and user accounts. 
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5.3.2 Deleting User Accounts 

If you no longer need a user account, use the following procedure to delete it. 

1. On the View menu, click User Accounts. The User Accounts screen appears, with a list of the 

user accounts that have been defined. 

2. Click the user whose account you want to delete, then click the Delete User button.  

5.4 Managing the xStack Storage Array  

This section shows you how to configure and manage storage on the xStack Storage Array. 

5.4.1 Working with Volumes 

A volume is a set of storage blocks organized and presented for use by a customer’s server (an 

iSCSI initiator node). Each volume must be associated with a storage pool, which limits the drives 

that can be used to hold data for that Volume (only drives in that pool can be used for this 

volume). Only the Blade A Base Pool can be used for volumes. 

The iSCSI initiator node sees the volume as a contiguous series of numbered blocks, called Virtual 

Logical Block Numbers (VLBNs), in the same way that it would see the storage space on a single 

disk drive. The xStack Storage Array builds a volume from extents. A volume typically consists of 

extents from several drives. 

Volume can be organized in several ways (see Table 5-2). 

Table 5-2 Ways to Organize Volumes 

 

Organization Definition Redundant Striped Equivalent 

to RAID 

Level 

JBOD One copy of the data is written to the selected Extents. No No - 

Mirror Two copies of all data are written to independent Extents. Yes No RAID 1 

Stripe Distributes one copy of the data among several drives to 
improve the speed of access. 

No Yes RAID 0 

Mirrored Stripe Distributes the data among several drives and then keeps a 
mirror copy of the blocks on each drive 

Yes Yes RAID 1+ 0 

Parity Distributes one copy of the data among several drives and adds 
parity blocks spread throughout the volume to protect against 
the loss of any single drive. 

Yes Yes RAID 5 
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5.4.1.1 Creating Volumes 

Adding volumes defines what volumes are accessible through the target. Using the management 

console, you can create volumes automatically or manually.  

� The automatic method is the fastest way to create volumes. See Section 5.4.1.1.1. 

� The manual method lets you customize and fine-tune volumes. See Section 5.4.1.1.2. 

5.4.1.1.1 Creating Volumes Automatically 

The following procedure describes how to create volumes automatically with the Create Volume 

Wizard. With this method, the administrator answers questions about the required redundancy, 

size, and usage characteristics of the volume. The xStack Storage Array then determines the 

remaining parameters needed to allocate the storage space and create the volume. As you create 

volumes, record the information in Appendix B. 

1. In the Logical Resources tab, click Blade A Base Pool. 

2. Perform one of the following steps in the Logical Resources tab: 

– Click the Create Volume button on the toolbar. 

– On the Storage menu, click Create Volume. 

– Right-click Blade A Base Pool and click Create Volume. 

Any of these steps starts the Create Volume Wizard and displays the Select Volume Type to 

Create screen (see Figure 5-11). 

 

Figure 5-11 Create Volume Wizard Screen – Select Volume Type to Create Screen 
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3. Complete the fields in the screen (see Table 5-3), then click the Next button. The Access and 

Efficiency Settings screen appears (see Figure 5-12).  

 

 

If you selected None or Mirror for Data Redundancy, only Access 

Bandwidth Weight appears in the Access and Efficiency Settings screen. 

 

Figure 5-12 Create Volume Wizard Screen – Access and Efficiency Settings Screen 

4. The default settings for Access Bandwidth Weight and Storage Efficiency Hint produce good 

volume organizations for each redundancy setting that use some, but not all, drive resources. 

If you change these settings (see Table 5-4), the number of members chosen for the volume 

depends on the number of drives available when the volume is created. Small settings use a 

small number of members. As setting values increase, the number of members increases 

slowly. When maximum values are reached, the xStack Storage Array uses all possible drives 

in the volume’s pool and the Available Pool for a volume. (Spare count is the only limit to 

the number of drives obtained from the Available Pool.) 

5. Click the Finish button. The main screen reappears, the volume you created appears under 

Blade A Base Pool in the Logical Resources tab, and a plus sign appears next to Blade A 

Base Pool. Clicking the plus sign displays the volume you created. 

 Table 5-3 Create Volume Wizard - Select Volume Type to Create Settings Screen Settings 

Setting Description 

Name Enter the name of the volume you are creating. 

Size Enter the size of the volume you are creating. Do not type a decimal point. Use the drop-down 
box to select the volume capacity (MB, GB, TB, etc.). All volumes must be at least 1 MB in size. 

Data Redundancy Select whether the volume will have no data redundancy or parity or mirror redundancy. For an 
explanation of these selections, see Table 5-2. 
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Table 5-4 Create Volume Wizard - Access and Efficiency Settings Screen Settings 

Setting Description 

Access Bandwidth Weight Specifies how much bandwidth the volume will use (i.e., how much initiator I/O activity can be 
expected for the volume). The larger the number, the greater the I/O. Select a large volume to 
have the initiators achieve fast access to the volume compared to the other volumes on xStack 
Storage Array. A large value selects a larger number of stripe members. The method the xStack 
Storage Array uses to select the organization and number of members is described in Table 5-5. 

Storage Efficiency Hint Specifies the xStack Storage Array’s member count selection. A large value increases disk space 
more efficiently (i.e., uses less space for redundancy data) and requests a larger number of 
members (which costs less space for parity overhead). 

Table 5-5 Volume Organization and Members Based on Redundancy and Access Bandwidth Weight 

Redundancy Access Bandwidth Weight Value 

 0 1 Large Values 

None JBOD organization (1 member) Stripe organization with 2 
members 

Stripe organization with more 
members 

Mirror Mirror organization (2 members) Mirrored stripe organization with 2 
stripe members 

Mirrored stripe organization with 
more stripe members 

Parity Parity organization with 3 
members 

In combination with the Storage Efficiency Hint, this selects Parity 
organization with more members  

 

 

In a mirrored stripe organization, there are always two members for each 

stripe member to allow for the duplicate copy of the data. 

 

 

After a volume is created, you can use the Advanced tab to write-protect 

the volume and suppress Synch Cache commands from the host (see 

5.4.1.4). 

5.4.1.1.2 Creating Volumes Manually 

The following procedure describes how to create volumes manually. With this method, you select 

the organization and other parameters, and specify drives that can be used for the volume. The 

xStack Storage Array then finds the storage space on the given drives to allocate and create the 

Volume. As you create volumes, record the information in Appendix B. 

1. In the Logical Resources tab, click the plus sign next to Blade A Base Pool. All drives 

available for volume creation appear under Blade A Base Pool. 

2. In the Logical Resources tab, click the plus sign next to Available Pool. 

3. If drives to be used for this volume are not already in the Blade A Base Pool, those drives 

need to be moved to that Pool. To do this, drag one of the desired drives from Available Pool 

to Blade A Base Pool. Repeat this step for each additional drive that you want included in 

the volume. 

4. In the Logical Resources tab, click Blade A Base Pool. 
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5. Perform one of the following steps in the Logical Resources tab: 

– Click the Manual Create Volume button on the toolbar. 

– On the Storage menu, click Manual Create Volume. 

The Manual Create Volume Wizard launches and the Select Volume Type to Create screen 

appears (see Figure 5-13). 

 

Figure 5-13 Manual Create Volume Wizard - Select Volume Type to Create Screen 

6. Complete the fields in the screen (see Table 5-6). 

7. Click the Next button. The Select the Drives screen appears (see Figure 5-14). 
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Figure 5-14 Manual Create Volume Wizard - Select the Drives Screen 

8. In the left box, select the drives from which the volume will be allocated, then click the Add 

button. Observe the following guidelines when selecting drives: 

– JBOD volumes support a minimum of 1 drive and can span across additional drives if the 

capacity required exceeds that which a single drive can provide. 

– Mirrored Stripe volumes support an even number of drives, from 4 to 14. 

– Parity volumes support 3 to 15 drives. 

– Mirror and striped volumes support 2 to 15 drives. 

 

 

You can select more than one drive in the left box: 

� To select contiguous drives, click the first drive; then hold down the Shift 

key and click the last drive. All drives between the first and last drives 

are selected. 

� To select noncontiguous drives, click the first drive; then hold down the 

Ctrl key and click each additional drive you want to select. 

� To deselect a drive, hold down the Ctrl key and click the drive. 

To remove a drive from the right box, click the drive in the right box and 

click Remove to return the drive to the left box. 

9. Click the Finish button. The main screen reappears and the volume you created appears 

under Blade A Base Pool in the Logical Resources tab. The drives that make up your volume 

appear in the main display. 
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If you select an unacceptable configuration, the Finish button remains gray 

and unavailable until you correct the configuration. Examples are an odd 

number of drives for a mirrored stripe configuration, 1 or 2 drives for a 

parity volume, and 1 drive for a Mirror configuration.  

If you specify a volume larger than the selected drives can support, an error 

message appears after you click the Finish button. Click OK to remove the 

message, then repeat this procedure and specify a smaller volume. 

Table 5-6 Manual Create Volume Wizard - Select Volume Type to Create Screen Settings 

Setting Description 

Name Enter the name of the volume you are creating. 

Size Enter the size of the volume you are creating ((MB, GB, TB, etc.). Do not type a decimal 
point. Use the drop-down box to select the volume capacity: 

Configuration Select the desired organization (JBOD, Stripe, etc.). Table 5-2 lists the volume 
organizations. 

Chunk Size Select the size (32K, 64K, etc.) of each chunk from one of the commonly used chunk 
sizes. If you selected JBOD or Mirror as your configuration setting, the Chunk Size 
setting is gray and unavailable. 

 

 

After a volume is created, you can use the Advanced tab to write-protect 

the volume and suppress Synch Cache commands from the host (see 

5.4.1.4). 

5.4.1.2 Expanding a Volume 

If you want to add capacity to a volume, expand the volume to increase its physical capacity.  

1. In the Logical Resources tab, click the volume whose capacity you want to expand. 

2. On the Storage menu, click Expand Volume. The Expand Volume dialog box appears (see 

Figure 5-15). 
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Figure 5-15 Expand Volume Dialog Box 

3. Use the New Size slide bar to increase the size of the volume.  

4. Click OK.  

5. When the Expand Volume started message appears (see Figure 5-16), click OK. 

 

 

If the selected volume cannot support the specified size, an error message 

appears. If this occurs, specify a smaller size. 

 

Figure 5-16 Expand Volume Message 
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5.4.1.3 Reconfiguring Volumes 

After you create a volume, you can reconfigure it if you need to change its size or its 

organization. 

1. In the Logical Resources tab, click the volume you want to reconfigure. 

2. Perform one of the following steps: 

– On the Storage menu, click Reconfigure. 

– Press the right mouse button and click Reconfigure. 

Either step starts the Auto Create Volume Wizard and displays the Select Volume Type to 

Create screen. For each screen in the Wizard, the xStack Storage Array shows the values for 

the Volume’s current organization. Except for the Volume’s Name, which is shown in gray, all 

fields can be changed. For example, you can change the Data Redundancy check box from 

None to Parity, which would change the Volume’s organization to Parity. 

3. Review the settings in the displayed screen and change them as necessary.  

4. Click the Finish button. 

5.4.1.4 Advanced Volume Operations 

When you click a volume under Blade A Base Pool, you can use the Advanced screen (see Figure 

5-17 and for a closeup, Figure 5-18 ) to write-protect the volume and disable Sync Cache 

commands from a host.  

 

Figure 5-17 Advanced Screen 
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Figure 5-18 Advanced Screen - Closeup 

5.4.1.4.1 Write-protecting Volumes  

Write-protecting a volume protects the data on the volume from being copied over or deleted 

either intentionally or by accident. On the “security” area of this screen, selecting Please set 

this volume to “Read-Only" adds write-protection to the volume, while selecting Do not set this 

volume as “Read-Only” removes write-protection. If an attempt is made to write data on a 

write-protected volume, the xStack Storage Array reports this attempt to the initiator requesting 

access to the volume and returns an error should any initiator try to write data. If the Read-Only 

selection is changed on this screen, the change takes effect immediately. 

5.4.1.4.2 Disabling Sync Cache Commands  

Some applications that stream media such as video can suffer performance problems if the host 

file system sends the SCSI Sync Cache command repeatedly. This command tells the xStack 

Storage Array to write to disk all data residing in cache. If you run applications that are sensitive 

to the Sync Cache command, you can configure the xStack Storage Array to ignore Sync Cache 

commands from the host. Doing so, however, places your data at greater risk than if the Sync 

Cache command was not ignored. . If the Sync Cache command selection is changed, the change 

takes effect immediately. 
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5.4.1.5 Deleting Volumes 

If you no longer need a volume, use the following procedure to delete it. 

 

 

You cannot delete a volume that is actively performing I/O for an iSCSI 

initiator. If you try to do so, the error “Volume Busy” is issued. If you really 

want to delete such a volume, log out of the target node and try to delete 

the volume again. 

1. In the Logical Resources tab, click the volume you want to delete. 

2. Perform one of the following steps: 

– On the Storage menu, click Delete Volume. 

– Press the right mouse button and click Delete Volume.  

A message asks whether you want to delete this volume. 

3. Click Yes to delete the volume. (Or click No to keep the volume.) If you clicked Yes, a 

message tells you that the volume has been deleted. 

Click OK to remove the message. 

5.4.1.6 Performing a Parity Scan on a Volume 

Using the management console, you can scan a parity volume for errors. This task reads every 

block in the volume to ensure that parity is correct. If parity errors are found, this task corrects 

the errors. 

1. Click the volume on which you want to perform the parity scan. 

2. Perform one of the following steps: 

– On the Storage menu, click Parity Scan.  

– Right-click and click Parity Scan. 

 

Either step starts the scan operation and displays a message that the scan started 

successfully. 

3. Click OK to remove the message. 

After you start a parity scan task, you can use the Tasks Info screen to view the progress of the 

scan operation (see Section 6.9). 

5.4.1.7 Performing a Media Scan on a Volume 

Using the management console, you can scan a JBOD, stripe, mirrored stripe, or mirrored stripe 

media volume for errors. This task reads every block in the volume looking for errors as described 

for Media Scan to ensure that the media is correct. If media errors are found, this task corrects 

the errors. 

1. Click the volume on which you want to perform the media scan. 
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2. Perform one of the following steps: 

– On the Storage menu, click Media Scan.  

– Right-click and click Media Scan. 

Either step starts the scan operation and displays a message informing you that the scan 

started successfully. 

3. Click OK to remove the message. 

After you start a media scan task, you can use the Tasks Info screen to view the progress of the 

scan operation (see Section 6.9). 

5.4.2 Adding iSCSI Initiators 

Use the following procedure to tell the xStack Storage Array about the iSCSI initiators with which 

it will communicate. 

1. Perform one of the following steps in the Logical Resources tab: 

– Click Initiator Resources. Then, on the iSCSI menu, click Add Initiator. 

– Right-click Initiator Resources and click Add Initiator. 

Either step displays the Create Initiator screen (see Figure 5-19). 

 

Figure 5-19 Add Initiator Wizard – Create Initiator Screen 

2. Complete the fields in the screen (see Table 5-7). 

3. Click the OK button. The main screen reappears and the iSCSI initiator you created appears 

under Initiator Resources in the Logical Resources tab. 

After you add one or more iSCSI initiators, you can monitor their status from the Initiator Access 

Info screen (Section 6.13), Initiator Information screen (Section 6.17), and LUN Map Information 

screen (Section 6.18). 
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Table 5-7 Create Initiator Screen Settings 

Setting Description 

Initiator Name Enter the name of the iSCSI initiator you are creating. This name must exactly match 
the name defined for the iSCSI initiator to which the xStack Storage Array will connect; 
otherwise, the connection will fail. 

Password To use Challenge Handshake Authentication Protocol (CHAP) authentication when 
connecting to an iSCSI target, type the password that will be used during mutual CHAP 
authentication when an initiator authenticates a target. For security, each typed 
character appears as an asterisk (*). This setting is optional. 

Confirm password If you typed a password, retype the same the same case-sensitive password in this 
field. For security, each typed character appears as an asterisk (*). 

5.4.3 Working with LAGs and VLANs 

The xStack Storage Array manages the data ports on the enclosure's back panel using the concept 

of LAG ports. In a simple configuration, a LAG port associates a single Ethernet port (i.e., a 

physical data port) with a network portal that defines an IP address.  

5.4.3.1 Creating LAGs and VLANs 

By default, each physical data port on the xStack Storage Array corresponds to a LAG: 

� DSN-3200: The default number of LAGs is eight. 

� DSN-3400: The default number of LAGs is one. Since this model has only one data port, it 

does not support LAG capabilities. 

In the default configuration, each data port corresponds to the LAG port of the same number. For 

example, the first LAG port (LAG 08000000) corresponds to Ethernet port 0 and to data port 0 

on the enclosure's back panel. Similarly, LAG 08000003 corresponds to Ethernet port 3 and to 

physical data port 3. No changes are necessary to use the xStack Storage Array in this 

configuration. 

Link Aggregation is a way to combine (or “aggregate”) multiple data ports in parallel to act as a 

single logical connection with increased bandwidth, and the xStack Storage Array can do this, 

too. 

Combining two or more data ports increases the overall bandwidth capability between the xStack 

Storage Array and your SAN, and creates resilient and redundant links. These capabilities are 

suited for demanding applications that run in high-performance environments, such as servers in 

enterprises, Web servers, and intranet servers, which can benefit from the high-bandwidth 

capabilities of link aggregation. 
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Figure 5-20 shows an example of a LAG created between the xStack Storage Array and a Gigabit 

Ethernet switch. In this example, multiple initiators (servers) that are used in a load balancing 

configuration can form one high-speed aggregated link. In this figure, the xStack Storage Array is 

connected to a Gigabit Ethernet switch using four 1 Gbps links. If one link fails between the 

xStack Storage Array and the switch, the other links in the LAG take over the traffic and the 

connection is maintained. A different example can be shown using the same figure but in a non-

load balancing configuration and with a larger number of initiators aggregated into the LAG. In 

this example, there could be six initiators connected to the switch that can participate in the 

LAG. At any point in time, if one initiator is generating less traffic, the others can generate more 

traffic, up to a maximum of 4 Gbps and the switch will balance the load. Since a single initiator 

does not typically generate continuous data, this configuration can allow better overall 

bandwidth utilization.  

 

Figure 5-20. Example of Link Aggregation between the xStack Storage Array and a Gigabit Ethernet Switch 

Using the following procedure, you can change this mapping so that a LAG consists of more than 

one physical port, depending on the requirements of the network (i.e., the more ports in the 

LAG, the more bandwidth and more redundancy that is available). When you create LAGs, you 

can indicate whether the LAG is to support a virtual LAN (VLAN). All xStack Storage Array models 

support eight VLANs, one for each IP address. As you create LAGs, record the information in 

Appendix B. 

1. In the Logical Resources tab, click the plus sign next to Target Resources. 

2. Click the plus sign next to Network Entities. 

3. Click LAG Resources.  

4. Perform one of the following steps: 

– On the Network menu, click Create LAG. 

– Right-click and click Create LAG. 

Either step starts the Create Link Aggregation Group Wizard and displays the LAG Parameters 

screen (see Figure 5-21). 
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Figure 5-21 Create Link Aggregation Group Wizard - LAG Parameters Screen 

5. Complete the fields in the screen (see Table 5-8). 

Table 5-8 Create Link Aggregation Group Wizard - LAG Parameters Screen Settings 

Setting Description 

MTU Size This is a read-only field. 

Ethernet Encapsulation Select the Ethernet frame type to be used for fetching packets from upper-layer 
protocols, and placing header and footer information around the data before it traverses 
the network. 

� Ethernet_II 

� Ethernet_802.3 

VLAN Supported Check this box to have the LAG support a Virtual Network (VLAN). 

Auto Negotiation This option is unavailable. 

6. Click the Next button. The Add/Delete Ethernet Ports screen appears (see Figure 5-22). 
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Figure 5-22 Create Link Aggregation Group Wizard - Add/Delete Ethernet Ports Screen 

7. To add Ethernet ports, select one or more ports in the left box and click Add to move them 

to the right box.  

8. To remove one or more Ethernet ports, select them in the right box and click Remove to 

move it to the left box. 

9. When you finish adding Ethernet ports, click the Finish button. 

After you create LAGs, you can monitor their status from the LAG Port Info screen (see Section 

6.14). 
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5.4.3.2 Modifying LAG Parameters 

There may be times when you need to modify LAG parameters. Using the management console, 

you can view the Maximum Transmission Unit (MTU) size and requested speed. As you modify LAG 

parameters, record the information in Appendix B. 

1. In the Logical Resources tab, click the LAG whose parameters you want to change. 

2. Perform one of the following steps: 

– On the Network menu, click Modify LAG Parameters. 

– Right-click and click Modify LAG Parameters. 

Either step displays the Modify LAG Parameters screen (see Figure 5-23). 

 

Figure 5-23 Modify Lag Parameters Dialog Box 

3. Complete the fields in the screen (see Table 5-9). 

4. Click OK. 

Table 5-9 Modify LAG Parameters Screen Settings 

Setting Description 

MTU Size This value specifies the maximum size of a packet that can be transferred in one frame 
over a network. 

Requested Speed This value indicates the requested speed for transmitting and sending packets. For the 
DSN-3200, the choices are Auto Detect, 100 Mbps, and 10 Mbps. For the DSN-3400, 
the only choice is 10GB. 
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5.4.3.3 Adding or Deleting Physical Ports in a LAG 

There may be times when you want to add physical ports to or delete physical ports from a LAG. 

The following steps describe this procedure. As you add or remove physical ports, record the 

information in Appendix B. 

1. In the Logical Resources tab, click a LAG whose physical port you want to configure. 

2. On the Network menu, click Configure Physical Port. The Add/Remove Ethernet Ports for 

LAG Wizard starts and the Add/Delete Ethernet Ports screen appears (see Figure 5-24). 

 

Figure 5-24 Add/Remove Ethernet Ports for LAG Wizard - Add/Delete Ethernet Ports screen 

3. To add Ethernet ports, select one or more ports in the left box and click Add to move them 

to the right box. 

4. To remove one or more Ethernet ports, select them in the right box and click Remove to 

move them to the left box. 

When you finish adding Ethernet ports, click the Finish button. 
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5.4.3.4 Deleting LAGs 

If you no longer need a LAG, use the following procedure to delete it. 

 

 

A warning message does not appear before you delete a LAG. Therefore, be 

sure you do not need the LAG before you delete it. 

1. In the Logical Resources tab, click the LAG you want to delete. 

2. Perform one of the following steps to delete the selected LAG: 

– On the Storage menu, click Delete LAG. 

– Right-click and click Delete LAG. 

5.4.4 Working with Network Portals 

The network portal is the physical Ethernet port attached to the host. Before you create a 

network portal, you must assign an IP address for the network portal and an IP address for the 

iSCSI initiator (if more than one iSCSI initiator will access this network portal, each initiator 

needs its own IP address). The initiator(s) and the network portal must have different IP 

addresses, yet reside on the same subnet. 

5.4.4.1 Creating Network Portals 

The following procedure describes how to create network portals. When you create a network 

portal, you specify the IP address for each xStack Storage Array data port that will be 

communicating with your iSCSI initiator. As you create network portals, record the information in 

Appendix B. 

 

 

Your iSCSI initiator(s) must be aware of the IP address(es) you specify in this 

procedure so it can communicate with the target xStack Storage Array. 

1. In the Logical Resources tab, click the plus sign next to Target Resources. 

2. Click the plus sign next to Network Entities. 

3. Click the plus sign next to LAG Resources. 

4. Under LAG Resources, click a LAG. 

5. Perform one of the following steps: 

– On the Network menu, click Create Network Portal. 

– In the Logical Resources tab, right-click a LAG and click Create Network Port.  

Either step starts the Create Network Portal Wizard and displays the Set the IP Address 

screen (see Figure 5-25). 
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Figure 5-25Create Network Portal Wizard – Set the IP Address Screen 

3. Complete the fields in the screen (see Table 5-10). 

4. Click the Finish button. 

5. If more than one data port will be communicating with your iSCSI initiator, repeat this 

procedure for each data port, making sure to assign the appropriate IP address for each data 

port. 

 

 

After you create the network portals, you can monitor their status using the 

Portals Information screen (see Section 6.15). 

Table 5-10 Create Network Portal Wizard – Set the IP Address Screen Settings 

Setting Description 

IP Address Enter the IP address for the network portal. The IP address must be a unique address 
that is different than the management port and on the same subnet as the iSCSI 
initiator. 

Subnet Mask Enter a subnet mask for the network portal or press the Tab key to automatically accept 
the default subnet mask. 

Default Gateway If a router is required for the xStack Storage Array to reach the initiator(s), the default 
gateway must have the IP address of that router. In a network that requires a router 
between the xStack Storage Array and the initiator, enter the router’s IP address. In a 
network that uses only direct connection, or a switch between the xStack Storage Array 
and the initiator(s), no entry is required.  
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5.4.4.2 Deleting Network Portals 

If you no longer need a network portal, use the following procedure to delete it. 

 

 

A warning message does not appear before you delete a network portal. 

Therefore, be sure you do not need the network portal before you delete it. 

1. In the Logical Resources tab, click the network portal you want to delete. 

2. Perform one of the following steps to delete the network portal: 

– On the Network menu, click Delete Network Portal. 

– Right-click and click Delete Network Portal. 

5.4.5 Creating iSCSI Target Nodes 

The iSCSI target node is the abstract entity used to permit access to the volumes on an xStack 

Storage Array by an initiator. The xStack Storage Array supports up to 1024 iSCSI target nodes. 

After you create one or more volumes, iSCSI initiators, and LAGs, you have all the prerequisites 

to create an iSCSI target node. As you create iSCSI target nodes, record the information in 

Appendix B. 

To create an iSCSI target node, use the following procedure. 

1. In the Logical Resources tab, click Target Resources or Network Entities. 

2. Perform one of the following steps: 

– On the iSCSI menu, click Create iSCSI Target Node. 

– Right-click and click Create iSCSI Target Node. 

Either step starts the Create iSCSI Node Wizard and displays the Enter iSCSI Node Information 

screen, which initially appears as in Figure 5-26. 

 

Figure 5-26. Create iSCSI Node Wizard - Enter iSCSI Node Information Screen 
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3. Complete the fields in the screen (see Table 5-11). 

Table 5-11 Create iSCSI Node Wizard - Enter iSCSI Node Information Screen Settings 

Setting Description 

iSCSI Node Alias An alias string can also be associated with an iSCSI node. The alias lets an organization 
associate a user-friendly string with the iSCSI name. This setting is optional. 

Enable CHAP Secret To use CHAP authentication to authenticate iSCSI connections, check this box to 
enable the CHAP secret. Then, in the CHAP Secret field, type the password that will be 
used by the xStack Storage Array to authenticate an initiator. This setting is optional. 
The CHAP secret is case sensitive. For security, each typed character in the CHAP 
secret appears as an asterisk (*). If you decide not to specify a CHAP secret now, you 
can do so in the future using the Set CHAP Secret command in the iSCSI menu. 

 

Figure 5-27. Create iSCSI Node Wizard - Enter iSCSI Node Information Screen with CHAP Secret Field Shown 

4. Click Next. The Configure iSCSI Node Parameters screen appears (see Figure 5-28 and Figure 

5-29). 
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Figure 5-28. Create iSCSI Node Wizard - Configure iSCSI Node Parameters Screen (Session Settings Tab) 

5. Accept the default settings in the Session Settings (see Figure 5-28)  and Connection 

Settings tabs (see Figure 5-29). 

 

Figure 5-29. Create iSCSI Node Wizard - Configure iSCSI Node Parameters Screen (Connection Settings Tab) 

6. Click Next. The Modify iSCSI Network Portal screen appears (see Figure 5-30). 
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Figure 5-30. Create iSCSI Node Wizard – Modify iSCSI Network Portals Screen 

7. In the left column, click the IP address of the network portal(s) allowed for this target node 

and click Add to move the IP address to the right list. To select additional IP addresses, 

repeat this step. (To remove an IP address from the right list, click it and click Remove to 

return the address to the left list.) When you finish, click Next. The Initiators List screen 

appears (see Figure 5-31). 

 

Figure 5-31. Create iSCSI Node Wizard – Initiator List Screen 
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8. The left box lists all the iSCSI initiators you have defined. Click the iSCSI initiator(s) in this 

list that are allowed to access the volumes through the target network portals whose IP 

addresses you selected in the previous screen. 

9. Click Add to move the selected iSCSI initiator(s) to the right box. 

 

 

If you want to remove an iSCSI initiator from the right box, click the iSCSI 

initiator in the right box and click Remove to return the iSCSI initiator to the 

left box. 

10. Click Next. The Volume Access Right screen appears (see Figure 5-32). 

 

Figure 5-32. Create iSCSI Node Wizard – Volume Access Right Screen 

11. The left box lists all the volumes you have created. Click a volume in this list, then click Add 

to move the selected volume to the right box. Note that all volumes currently can have only 

Read/Write access, which is the default. 

 

 

You can select more than one volume in the left box: 

� To select contiguous volumes, click the first one; then hold down the Shift 

key and click the last volume. 

� To select noncontiguous volumes, click the first volume; then hold down 

the Ctrl key and click each additional volume you want to select. 

� To deselect a volume, hold down the Ctrl key and click the volume. 
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To remove a volume from the right box, click the volume in the right box 

and click Remove to return the volume to the left box. 

10. Click Finish. On completion, the xStack Storage Array assigns a world-wide unique name to 

the iSCSI target node. You can use the procedure in Section 6.11 to view the name and the 

other target node parameters. 

5.4.5.1 Changing the CHAP Secret 

When you created an iSCSI target node, you could specify an optional CHAP secret. If you did not, 

you can use the following procedure to specify one. You can also use this procedure to change 

the CHAP secret. Record the information in Appendix B. 

1. Click a network entity (prefaced by naa) in the Logical Resources tab. 

2. On the iSCSI menu, click Change CHAP Secret. The Set CHAP Secret dialog box appears (see 

Figure 5-33). 

 

Figure 5-33. Set CHAP Secret Dialog Box 

3. Complete the fields in the dialog box: 

– CHAP Secret. Enter the CHAP secret. 

– Confirm CHAP Secret. Enter the same CHAP secret. 

 

 

The CHAP secret is case sensitive. For security, each typed character in 

CHAP Secret and Confirm CHAP Secret appears as an asterisk (*). 

4. Click OK. 
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5.4.6 Logging on from the iSCSI Initiator Computer 

For an iSCSI initiator node to access the volumes in a target node, it must log in to that target 

node. After you create a volume, an iSCSI initiator, a network portal, and iSCSI target nodes, you 

can log on to the xStack Storage Array from the iSCSI initiator computer.  For example, using the 

DSN-3200: 

1. Use an Ethernet RJ-45 cable to connect the appropriate xStack Storage Array Ethernet port 

to the NIC in the iSCSI initiator computer or to your Ethernet switch. 

2. Configure the iSCSI initiator for use with the xStack Storage Array. This step varies according 

to the operating system used with the iSCSI initiator. For more information, please refer to 

the instructions for your iSCSI initiator software. 

3. Use the initiator software to Log In to the xStack Storage Array. The software should confirm 

the log in with a response such as “Connected” and the initiator computer should be able to 

see the volumes on the xStack Storage Array. 

The log in process is begun by the initiator when it sends a log in request packet which includes 

the world-wide unique name of the target node. The xStack Storage Array will accept the log in if 

all of the following conditions are met: 

� The initiator’s name is in the list of allowed initiators for that target node. 

� The initiator connected to the xStack Storage Array using an xStack Storage Array IP address 

and port number in the list of allowed network portals for that target node. 

� The CHAP secret (if CHAP is enabled) for the target node matches the one given by the 

initiator. In addition, if CHAP is enabled and the initiator was given a password (on the 

xStack Storage Array), the xStack Storage Array uses the CHAP protocol to validate that 

password with the initiator. 

In addition, a set of configuration parameters are negotiated between the initiator and target 

during log in. A description of all the configuration parameters is beyond the scope of this 

document. For more information, refer to the iSCSI IETF specification. 

5.4.7 Changing the iSCSI Port Number 

The iSCSI port number is the TCP/IP port number on which the iSCSI target is listening. The 

standard port number for iSCSI is 3260, but some targets may allow the port number to be 

customized. The following procedure describes how to change the iSCSI port number. 

 

 

Changing this parameter is not recommended. 

1. Click the xStack Storage icon on the Physical Resources tab. 

2. Perform one of the following steps: 

– On the File menu, click Change iSCSI Port Number.  

– Right-click and click Change iSCSI Port Number. 
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Either step displays the Modify iSCSI Port dialog box, with the current iSCSI port number 

shown (see Figure 5-34). 

 

Figure 5-34 Modify iSCSI Port Dialog Box 

2. Enter a new value for the iSCSI port. 

3. Click OK. The new iSCSI port number will take effect after the next controller restart. 

5.4.8 Setting the Default Task Priority 

You can set the default task priority to specify whether background tasks receive a high or low 

priority. By default, the default task priority provides for minimum impact on the foreground 

applications performed by the xStack Storage Array. However, you can change this setting if 

desired. For example, you may want to specify a higher default task priority for time-critical 

tasks such as backups. 

 

 

By changing the default task priority to a high priority, the xStack Storage 

Array will spend more resources performing tasks and fewer resources 

performing I/O for its initiators, potentially decreasing its performance (as 

observed from the initiators). If you want to change the priority of a single 

critical task, you can change the priority of that task without changing all 

tasks. 

To set the default task priority, use the following procedure. 

1. On the File menu, click Set Default Task Priority. The Set Default Task Priority dialog box 

appears, with the current setting shown (see Figure 5-35). 
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Figure 5-35 Set Default Task Priority Dialog Box 

2. Use the slider switch to specify the default priority level (0 = highest priority, 10 = lowest 

priority). 

3. Click OK. 

5.4.9 Adding, Viewing, and Deleting IP Route Tables 

Routing is the process of deciding the disposition of each incoming and outbound packet that the 

xStack Storage Array handles. Using the management console, you can view the xStack Storage 

Array’s routing table. If a route being used encounters problems, you can use the management 

console to add route tables. Adding a route is also useful if you discover a quick alternative route 

to the destination. You can also use the management console to delete routes. 

1. On the View menu, click View Manual Route. The View Route Table appears, with the 

current route tables shown (see Figure 5-36). 

 

Figure 5-36. View Route Table 
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2. To add a route to the routing table, click the Add button. Then, when the dialog box in 

Figure 5-37 appears, complete the fields and click OK. As you add route entries, record the 

information in Appendix B. 

 

Figure 5-37. Adding a Route Table 

3. To delete a route, click the route in the View Route Table and click the Delete button. 

 

 

A warning message does not appear before you delete a route. Therefore, be 

sure you do not need the route before you delete it. 

Table 5-12 Route Table Settings 

Setting Description 

Destination Enter the IP address of the destination for this route. 

Netmask Enter the netmask (subnet mask) associated with the network destination or press the 
Tab key to automatically set the default subnet mask to 255.255.255.0. 
Because of the relationship between the destination and the subnet mask in defining 
routes, the destination cannot be more specific than its corresponding subnet mask. In 
other words, there cannot be a bit set to 1 in the destination if the corresponding bit in 
the subnet mask is a 0. 

Gateway Specifies the forwarding or next hop IP address over which the set of addresses defined 
by the network destination and subnet mask are reachable. For locally attached subnet 
routes, the gateway address is the IP address assigned to the interface that is attached 
to the subnet. For remote routes, available across one or more routers, the gateway 
address is a directly reachable IP address that is assigned to a neighboring router. 

Metric Specifies an integer cost metric (from 1 to 9999) for the route, which is used when 
choosing among multiple routes in the routing table that most closely match the 
destination address of a packet being forwarded. The route with the lowest metric is 
chosen. The metric can reflect the number of hops, the speed of the path, path 
reliability, path throughput, or administrative properties. 
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5.4.10 Modifying System TCP/IP Settings 

You can use the management console to view and change the system’s TCP/IP settings. 

1. Click the xStack Storage icon on the Physical Resources tab. 

2. Perform one of the following steps: 

– On the File menu, click Modify System TCP/IP Settings.  

– Right-click and click Modify System TCP/IP Settings. 

Either step displays the Modify System TCP/IP Settings dialog box appears, with the current 

setting shown (see Figure 5-38).  

 

Figure 5-38. Modify System TCP/IP Settings Dialog Box  

3. Complete the fields in the dialog box (see Table 5-13). 

4. Click OK. 
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Table 5-13 Modify System TCP/IP Settings Dialog Box Settings 

Setting Description 

Max Segment Size Indicates the maximum size TCP segment that can be accepted on a TCP/IP 
connection when the connection is established. 

Window Scale Lets you use large windows during TCP/IP connections. On fast, high-bandwidth 
networks, a large TCP window provides greater efficiency by allowing for a greater 
amount of unacknowledged data. 

TCP Timestamp Enabled Causes the receiving computer to send a time-stamp reply back to the originating 
computer. Systems can use time-stamp requests and replies to measure the 
transmission speed of datagrams on a network. 

Time to Live (TTL) Specifies the default time to live (TTL) value for IP packets generated by the Windows 
TCP/IP stack. 

PMTU Enabled Lets the xStack Storage Array automatically adapt its packet size. Disabling this option 
forces the system to keep its default packet size (576 bytes), even when it receives an 
ICMP request to change its packet size; this can render some remote systems 
unreachable, because if intermediate systems on the path to the remote system cannot 
support the default packet size, the xStack Storage Array ignores their requests to make 
the packets smaller. 

Upper Layer Count Reset Resets the TCP/IP upper layer counters. Resetting the counters simplifies the ability to 
look at the counters for an accurate percentage of packets sent or received. 

5.4.11 Setting the Spare Count 

A spare is a drive that is present in the system (in the Available Pool) that cannot be used for 

any reason, except to rebuild space used by a volume on a failed drive. If a drive fails, the xStack 

Storage Array tries to find a replacement extent for every extent on that failed drive that was 

part of a redundant volume. First, a replacement extent is sought on a drive in the volume’s pool 

(currently, the Blade A Base Pool). If space is not found in that pool and a drive exists in the 

Available Pool, one drive is obtained from the Available Pool and an extent is selected from that 

drive. In either case, a rebuild task starts to rebuild the volume’s extent. If the available pool is 

empty, some volumes may not be rebuilt. The spare count exists to reduce that likelihood. 

The spare count default is 0, which means that no drives are kept in reserve for use in rebuilding 

extents (i.e., all drives can be obtained from the Available Pool for any purpose). Automatic 

Volume Creation, for example, takes drives from the Available Pool automatically as needed to 

satisfy the parameters in the request. If the spare count is set to a non-zero value, that number 

of drives is retained in the Available Pool for use only for rebuilds (i.e., operations other than 

rebuild cannot take a drive from the Available Pool if taking that drive results in the Available 

Pool having fewer drives than the spare count value). For example, assume that the spare count 

is one in an enclosure with 12 drives installed. If the administrator tried to perform an Automatic 

Volume Creation with both sliders at 10 (their maximum values), the volume is created using 11 

drives, without touching the twelfth. If a drive fails, the twelfth drive moves automatically from 

the Available Pool to the volume’s pool, so its space can be used to rebuild the original failed 

extent. 

1. Click the xStack Storage icon on the Physical Resources tab. 

2. Perform one of the following steps: 

– On the File menu, click Set Spare Count.  
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– Right-click and click Set Spare Count. 

Either step displays the Set Spare Count dialog box, with the current setting shown (see 

Figure 5-39). 

 

Figure 5-39. Set Spare Count Dialog Box 

Enter a value that corresponds to the number of drives and click OK. 

5.4.12 Using the Down Drive Feature 

The xStack Storage Array provides a Down Drive feature that allows a drive to be removed from 

the system in an orderly way. Using this feature, you can, for example, replace a smaller drive 

with a larger drive, or replace a drive for which S.M.A.R.T. has projected a failure. The xStack 

Storage Array can perform up to five concurrent Down Drive operations at one time. 

The Down Drive operation requires all space used on the drive to be relocated onto different 

drives. The Down Drive feature handles this requirement by performing a reconfigure task on 

every volume that uses space on the drive. This operation is conducted for any type of volume, 

including redundant and non-redundant organizations. 

When all space has been moved off the drive, the drive is moved to the Unusable Pool and can 

be removed from the system. 

5.4.12.1 Initiating the Down Drive Operation 

To use the Down Drive feature, right-click the drive you want to remove and click Down Drive. 

The Down Drive task appears in the task pane of the xStack Storage Array management console. 

One reconfigure task is created automatically for each volume that used space on the selected 

drive. The reconfigure tasks are issued one at a time. The progress of the Reconfigure and Down 

Drive tasks can be monitored on the task pane. 

5.4.12.2 Suspending and Resuming the Down Drive Operation 

To suspend the Down Drive operation: 

1. Select the Down Drive task. 

2. Right-click and select the Suspend option. 

To resume the Down Drive operation, right click and select the Resume option. 
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When a Down Drive operation is suspended or resumed, any reconfigure task controlled by that 

Down Drive operation automatically changes state to Suspend or Restore, respectively. Do not try 

to suspend or resume the reconfigure task directly; always change the Down Drive task. 

5.4.13 Using the xStack Storage Array’s iSNS Features 

Internet Storage Naming Service (iSNS) facilitates the automated discovery, management, and 

configuration of iSCSI and Fibre Channel devices on a TCP/IP network. iSNS provides intelligent 

storage discovery and management services comparable to those found in Fibre Channel 

networks, allowing a standard IP network to operate in much the same way that a Fibre Channel 

SAN does. Because iSNS can emulate Fibre Channel fabric services and manage both iSCSI and 

Fibre Channel devices, an iSNS server can be used as a consolidated configuration point for an 

entire storage network. 

The xStack Storage Array management console supports two iSNS configuration options: 

� The xStack Storage Array management console can use an iSNS server to discover all 

registered iSCSI Initiators and add them into the xStack Storage Array internal CIM database. 

The xStack Storage Array can register itself for discovery by the iSNS server. 

5.4.13.1 Discovering All Registered iSCSI Initiators 

To discover all registered iSCSI initiators, use the following procedure. 

1. On the File menu, click Configure iSNS Client. The iSNSClient dialog box appears (see Figure 

5-40). 

 

Figure 5-40. iSNS Client Dialog Box 

 

2. Complete the fields in the Configure iSNS Client area (see Table 5-14). 

3. Click OK. The xStack Storage Array CIM database is updated with all the available initiators 

registered with the server. To view the initiators, go to the Logical Resources tab under 

Initiator Resources. 
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Table 5-14. iSNSClient Dialog Box 

Setting Description 

iSNS Server IP Address Enter the IP address of the iSNS server. 

iSNS Server Port Number Enter the port number on which the iSNS server is communicating. The default port 
number is 3205. 

5.4.13.2 Registering the xStack Storage Array with an iSNS Server 

To register the xStack Storage Array with an iSNS server, use the following procedure. 

1. On the File menu, click Configure System iSNS. The Configure System iSNS dialog box 

appears (see Figure 5-41). 

 

Figure 5-41. Configure System iSNS Dialog Box 

 

4. Complete the fields in the dialog box (see Table 5-15). 

5. Click OK. The settings are saved and the xStack Storage Array registers itself with the iSNS 

server. 
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Table 5-15. Configure System iSNS Settings Box 

Setting Description 

iSNS Enable Check this box to enable the other settings in the dialog box. If this box is not checked, 
the other settings in this dialog box are ignored. 

iSNS Server IP Address Enter the IP address of the server running the iSNS service. 

iSNS Server Subnet Mask Enter the subnet mask of the server running the iSNS service. 

iSNS Server Port Number Enter the port number on which the server running the iSNS service s listening. The 
default port number is 3205. 

Heartbeat IP Address Enter the IP address from which the iSNS heartbeat originates. Typically, this address is 
the same as the iSNS server IP address, though it may be different. 

Heartbeat Subnet Mask Enter the subnet mask from which the iSNS heartbeat originates. Typically, this subnet 
mask is the same as the iSNS server subnet mask, though it may be different. 

5.4.14 Creating Scheduled Tasks 

You can use the management console to set up tasks you want the xStack Storage Array to 

perform, such as parity or media scans. When you create a task, you specify the day and time 

when it is to be performed and whether the task will repeat (recur). As you create scheduled 

tasks, record the information in Appendix B. 

1. On the View menu, click Create Task. The Scheduled Task Wizard launches and the Volume 

and Operation screen appears (see Figure 5-42). 

 

Figure 5-42 Scheduled Task Wizard – Volume and Operation 

2. Complete the fields in the screen (see Table 5-16). 

3. Click Next. The Select Date and Time screen appears (see Figure 5-43). 
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Figure 5-43. Scheduled Task Wizard – Select Date and Time Screen 

4. Complete the fields in the screen (see Table 5-17). 

5. Click Finish. 

After scheduling tasks, you can view their status from the Tasks Info screen (see Chapter 6). 

Table 5-16 Scheduled Task Wizard – Volume and Operation Screen Settings 

Setting Description 

Object Select the volume on which the scheduled task will be performed. 

Operation Select the task that is to be performed. 

Perform this Task Select how often the scheduled task is to be performed. 

Table 5-17 Scheduled Task Wizard – Select Date and Time Screen Settings 

Setting Description 

Start Time Use the controls to specify the time when the scheduled task is to start. 

Start Date Use the calendar to select the date when the scheduled task is to start. You can use the 
controls below the calendar to move to the previous year, previous month, next month, 
or next year. 
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5.4.15 Setting the System Battery Policy 

If your xStack Storage Array has an onboard battery, the system battery policy defines how 

contents in cache memory are handled if the battery is not fully charged. By default, the xStack 

Storage Array is configured to buffer all I/O in cache memory. You can, however, change this 

setting to protect data against situations when the battery is not fully charged.  

1. Click the xStack Storage icon on the Physical Resources tab. 

2. Perform one of the following steps: 

– On the File menu, click Set System Battery Policy.  

– Right-click and click Set System Battery Policy. 

Either step displays the Battery Policy dialog box appears, with the current setting shown 

(see Figure 5-44). The icon at the top of the dialog box provides a color-coded indication of 

the xStack Storage Array battery status. 

 

Figure 5-44. Battery Policy Dialog Box 

3. Select the appropriate setting that the xStack Storage Array should whenever the battery is 

not fully charged (see Table 5-18).  

4. Click OK. 

Table 5-18 Battery Policy Settings 

Setting Description 

Ignore the status of the battery and 
do nothing 

No action is taken to protect the contents of cache data in the event of an uncharged 
battery. If the xStack Storage Array loses AC power, its onboard battery will be used to 
protect the contents of cache memory (up to 72 hours for a fully charged battery). 

Stop buffering I/O in cache, and 
directly write data to disk 

I/O buffered in cache memory is written to disk whenever the xStack Storage Array 
battery is not fully charged. 

Prevent any reads from or writes to 
volumes 

Stops all read and write operations whenever the battery is not fully charged. 
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The xStack Storage Array battery is designed to provide backup power in the 

event of a power failure. If a power failure occurs, a fully charged battery 

will protect the contents of buffer memory for 72 hours. 

5.4.16 Saving the Event Log 

The event log tracks the xStack Storage Array informational, warning, and error messages (see 

Section 6.2). Using the management console, you can save the event log as an unformatted text 

file to a user-specified folder. 

1. Be sure the Physical Resources tab is the active tab and select the Log Messages tab. 

2. Scroll the page down to make sure that all messages you want to save can be viewed. 

3. On the View menu, click Save Event Log Messages. The Open dialog box appears (see Figure 

5-45). 

 

Figure 5-45. Open Dialog Box 

4. Using the Open dialog box, navigate to the location where you want the event log text file to 

reside. 

5. In the File name field, enter a name for the event log text file. 

6. Click OK. 
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5.5 Changing Initial Configuration Settings 

When you started the xStack Storage Array for the first time, you specified the unit’s initial 

settings using the OOBE setup wizard. You may need to change these settings in the future. For 

example, you may need to change the date and time if time changes occur in your area. 

The following sections describe how to change the settings you specified during the OOBE setup 

wizard. 

5.5.1 Changing the Out-of-Band Port Configuration  

You specified the management interface settings in the OOBE setup wizard when you started the 

xStack Storage Array for the first time. If you need to change these settings, perform the 

following procedure: 

1. Click the xStack Storage icon on the Physical Resources tab. 

2. Perform one of the following steps: 

– On the File menu, click Configure Out of Band Port. 

– Right-click and click Configure Out of Band Port.  

Either step displays the Configure Out of Band Port dialog box (see Figure 5-46). 

 

Figure 5-46 Configure Out of Band Port Dialog Box 

3. Complete the fields in the dialog box (see Table 5-19). 

 

 

For convenience, the current settings appear below each field. Remember 

the new IP address; you will need it for subsequent logins to the console. We 

recommend that you record the IP address in Appendix B. 

4. On the File menu, click Restart. When the confirmation prompt “Do you want to restart the 

system?” appears, click Yes. 
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5. After the xStack Storage Array has become ready and reboot is complete, launch the 

browser, enter the new IP address, and click Go on the browser. The Login Screen initializes 

and the username and password must be re-entered. 

 

 

If the Login Screen does not appear, be sure you entered the new IP address 

in your browser. If you changed the subnet for the xStack Storage Array, be 

sure you configured the NIC in the management PC to use that subnet. 

Table 5-19. Configure Out of Band Port Dialog Box Settings 

Setting Description 

IP address after restart Enter an available IP address that will take effect after the xStack Storage Array 
restarts. Write the new IP address on paper for reference purposes. 

Subnet Mask after restart Enter the subnet mask that will take effect after the xStack Storage Array restarts. 
Configure the NIC in the management PC to use the same subnet. 

Host name after restart The xStack Storage Array is assigned a default host name. If desired, you can change 
this name to one that is meaningful to you. 

Gateway after restart Enter the gateway that will take effect after the xStack Storage Array restarts. 

5.5.2 Changing the System Date and Time 

You specified the system date and time settings in the OOBE setup wizard when you started the 

xStack Storage Array for the first time. If you need to change these settings, perform the 

following procedure: 

1. Click the xStack Storage icon on the Physical Resources tab. 

2. Perform one of the following steps: 

– On the File menu, click xStack Storage Date and Time.  

– Right-click and click xStack Storage Date and Time. 

Either step displays the xStack Storage Date and Time dialog box (see Figure 5-47). 

 

Figure 5-47 xStack Storage Date and Time Dialog Box 
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3. Complete the fields in the dialog box (see Table 5-20). 

4. Click OK.  

5. Restart the xStack Storage Array for the new settings to take effect. 

Table 5-20. xStack Storage Date and Time Dialog Box Settings 

Setting Description 

Timezone Select the appropriate timezone from the drop-down list. 

System Date Use the controls to the right of this field to select the appropriate system date or click the 
calendar icon and select a date from the popup calendar. 

System Time Use the controls to the right of this field to select the appropriate system time. 

5.5.3 Changing Email Notification Setup 

You may have specified email notification settings in the OOBE setup wizard when you started 

the xStack Storage Array for the first time. If you need to change these settings, or if you want to 

enable or disable this feature now, perform the following procedure: 

1. Click the xStack Storage icon on the Physical Resources tab. 

2. On the File menu, click Configure Email Notification. The Configure Email Notification 

dialog box appears (see Figure 5-48). 

 

Figure 5-48 Configure Email Notification Dialog Box 
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3. Complete the fields in the dialog box (see Table 5-21). 

4. Click OK.  

Table 5-21. Configure Email Notification Dialog Box Settings 

Setting Description 

Enable Email Notification Support Click this option to enable email notifications from the xStack Storage Array. 

From Address Enter the email address of a user. Each email sent by the xStack Storage Array will be 
identified as being sent from this user. 

To Address Enter the email address where notifications are to be sent. This can be an individual 
email address or a distribution list. 

SMTP Server Enter the IP address of the mail server through which email notifications from the xStack 
Storage Array will be routed. 

SMTP Port Enter the SMTP port on which the mail server will be listening for email alerts from the 
xStack Storage Array (default is 25). 

5.6 Managing xStack Storage Array Configurations 

The management console provides options for saving and restoring the xStack Storage Array 

configuration. You can also return the xStack Storage Array to its factory-default settings. 

5.6.1 Saving the xStack Storage Array Configuration 

To save the current xStack Storage Array configuration, use the following procedure. 

1. On the File menu, click Save xStack Storage Configuration. The Save xStack Storage 

Configuration dialog box appears (see Figure 5-49). 

 

Figure 5-49 Save xStack Storage Dialog Box 
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2. Navigate to the location where you want to save the configuration. 

3. In the File name field, type a name for the configuration. 

4. Click the Save button. 

5.6.2 Restoring the xStack Storage Array Configuration 

If you used the procedure in Section 5.6.1 to save the xStack Storage Array configuration, you 

can use the following procedure to restore the saved configuration. 

1. On the File menu, click Restore xStack Storage Configuration. The Restore xStack Storage 

Configuration dialog box appears (see Figure 5-50). 

 

Figure 5-50. Restore xStack Storage Configuration Dialog Box 

2. Locate the configuration file whose settings you want to load, then select the file and click 

the Open button. The message in Figure 5-51 appears. 

 

Figure 5-51. Configuration Restore Message 

3. Click Yes to restore the configuration. (Or click No to keep the current configuration.) If you 

clicked Yes the xStack Storage Array restarts and loads the selected configuration. 
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5.6.3 Restoring Factory Defaults 

To return the xStack Storage Array to its factory-default settings, use the following procedure. 

 

 

For firmware 1.4.0.27 and later, when you return to the factory-default settings, 

you are given the choice to return the management port to its default address of 

192.168.1.1 or keep the address already specified. 

1. On the File menu, click Restore Factory Defaults. A message tells you that you may have to 

restart the xStack Storage Array and asks whether you want to proceed.. 

2. Click Yes to restore the factory-default settings. (Or click No to keep the current 

configuration.)  

3. If you clicked Yes, another dialog box asks whether you want to keep the current 

management port configuration settings. Click Yes to keep them and proceed, No to revert 

to the default management port settings and proceed, or click Cancel to cancel the 

operation.  

4. If you clicked Yes or No, the xStack Storage Array loads the factory-default settings (and 

those for the management port if you clicked Yes) and displays the message to let you know 

that restore to factory defaults was successful. 

5. Click OK to restart the xStack Storage Array with the factory-default settings. When the 

xStack Storage Array restarts, the first attempt to log in with a Web browser will run the Out-

of-Box Experience setup wizard (see Chapter 4). 

5.7 Restarting the xStack Storage Array 

To restart the xStack Storage Array, use the following procedure. 

1. Log off from all iSCSI initiators. 

2. Click the xStack Storage icon on the Physical Resources tab. 

3. Perform one of the following steps: 

– On the File menu, click Restart System. 

– Right-click and click Restart System. 

Either step displays a message that asks whether you are sure you want to restart the system. 

4. Click Yes to restart the system (or click No to keep the system running). If you clicked Yes, 

your management console session ends and the xStack Storage Array is restarted. You can 

then use the log in procedure earlier in this chapter to log into the management console. 
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5.8 Shutting Down the Management Console 

To shut down the management console, use the following procedure. 

1. Click the Physical Resources tab. 

2. Perform one of the following steps: 

– On the File menu, click Exit. 

– Click the Close control on the title bar. 

5.9 Shutting Down the xStack Storage Array 

At the end of your session, use the following procedure to shut down the management console. 

When you shut down the xStack Storage Array, it powers off automatically. 

 

 

The following steps are the proper procedure for shutting down the xStack 

Storage Array. Failing to use this procedure to shut down the xStack Storage 

Array will result in battery power degradation if a UPS is not used. 

1. Log off from all initiators. 

2. Click the xStack Storage icon on the Physical Resources tab. 

3. Perform one of the following steps: 

– On the File menu, click System Shutdown. 

– Right-click and click Shutdown System.  

Either step displays a message that asks whether you are sure you want to shut down the 

system. 

Click Yes to shut down the system (or click No to keep the system running). If you clicked Yes, 

your management console session ends and the xStack Storage Array is powered off.
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Chapter 6 Monitoring the xStack Storage 

This chapter describes the management console screens that appear in the main area for viewing 

system and storage information. Some screens are available from either the Logical Resources or 

Physical Resources tab. Other screens are available from both tabs. Use Table 6-1 to find the 

screen that contains the information you want to view. 

Table 6-1 xStack Storage Array Screens 

For Information About… Use This Screen See Section 

Drives in the Blade A Base Pool or on the Physical Resources tab Drive Information screen 6.10 

Ethernet ports in the Physical Resources tab Ethernet Port Information screen 6.19 

Connection parameters and session information for a selected 
connection 

Connection Information screen 6.16 

Event log messages Log Messages screen 6.2 

Firmware image Firmware Image Info screen 6.5 

xStack Storage enclosure Enclosure Information screen 6.1 

xStack Storage tasks Tasks Info screen 6.7 

IP addresses and port numbers for a selected network entity Portals Info screen 6.15 

iSCSI initiators Initiator Information screen 6.17 

iSCSI initiators and access for a selected network entity Initiator Access Info screen 6.13 

LAG ports LAG Port Info screen 6.14 

LUN mapping for a selected iSCSI initiator LUN Map Information screen 6.18 

LUN mapping for a volume on a selected network entity Volume Access Info screen 6.12 

Session and connection parameters for a selected network entity Target Node Info screen 6.11 

SMART attributes SMART Attributes 6.10.2 

SMART data SMART Data screen 6.10.2 

Storage Management Initiative (SMI) server and profile Server SMI Information screen 6.4 

Storage pools parameters Storage Group Information screen 6.6 

Tasks assigned to storage pools Tasks Info screen 6.7 

Tasks assigned to volumes Task Info screen to view tasks 6.9 

Volume information Volume Information screen 6.8 
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6.1 Viewing Enclosure Information 

When the xStack Storage icon is selected in the Physical Resources tab, you can use the 

Enclosure Information screen to view information about the xStack Storage Array enclosure (see 

Figure 6-1). This screen is divided into three areas: 

� Message Log Summary. The Message Log Summary summarizes the current error, warning, 

and information messages in the event log. To enhance visibility, the three message types are 

color coded.  

– Error messages are red and indicate something unexpected has occurred that may be a 

serious problem. 

– Warning messages are yellow. Warning messages indicate that something appeared wrong 

but has been corrected. They also provide notification about things that may be expected 

but are of particular interest. 

– Informational messages are green. Informational messages contain information about steps 

performed, detected version information, and miscellaneous messages. 

For more information about a message, go to the Log Messages screen (see Section 6.2). 

 

 

If your xStack Storage Array supports Enclosure Services and an error occurs, 

email notification is sent, the Fault/Ready LED illuminates red (chassis 

support required) and the Message Event Log identifies an error. If the 

temperature exceeds the overheat temperature limit, the xStack Storage 

Array shuts down automatically. 

 

Figure 6-1 Enclosure Information Screen 
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6.2 Viewing Log Messages 

When the xStack Storage icon is selected in the Physical Resources tab, you can use the Log 

Messages screen to view the entries in the event log (see Figure 6-2).  

 

Figure 6-2 Log Messages Screen 

The messages are color coded, making it easy to differentiate among informational, warning, and 

error messages. The messages are time- and date-stamped, with the most recent entry appearing 

at the top of the screen. 
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Log messages fall into one of three categories: 

� Informational messages convey information of interest. The following is an example of an 

informational message: 

 
 

� Cautionary messages indicate a minor problem that should not impede the use of the 

resource. The following is an example of a cautionary message: 

 
 

� Alarm messages indicate that a severe condition exists that could potentially cause a problem 

with resources. The following is an example of an alarm message: 

 

To obtain additional information about a message shown in the Log Messages screen, double-click 

the message. A Log Message Details box appears, with detailed information about the message. 

The box also provides buttons for moving to the next or previous message in the message log and 

an OK button for exiting.  

 

 

 You can save the event log entries as an unformatted text file to disk. The 

messages saved are the ones shown in Figure 6-2 plus the ones seen when 

you scroll the page down. Before saving this log, scroll down as far as 

needed to be sure you will be saving all the messages desired. For more 

information, see Chapter 5. 
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6.3 Viewing, Modifying, and Deleting xStack Storage Array Tasks 

When the xStack Storage icon is selected in the Physical Resources tab, you can use the Tasks 

Info screen to view the xStack Storage Array tasks (see Figure 6-3). Examples of tasks include bad 

block scan and volume initialization activities.  

Each row of the Tasks Info screen corresponds to a task. The last column, Recurring, shows 

whether the task is recurring and will repeat again in the future. 

 

Figure 6-3 Tasks Info Screen 

To obtain additional information about a task shown in the Tasks Info screen, double-click the 

task. A Task Message Details box appears, with detailed information about the task. If you right-

click a task in the Tasks Info screen, a popup appears. Depending on the options that are 

available, you can perform the following tasks from the Tasks Info screen: 

� Set a priority for the selected task. 

� Suspend or resume the task. 

� Cancel the task to stop the current task from being performed.  If the task was recurring, it 

will no longer start on any future occurrence. 

� Delete the task. 
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6.4 Viewing Server SMI Information 

When the xStack Storage icon is selected in the Physical Resources tab, you can use the SMI 

Server Info screen to view Storage Management Initiative (SMI) server and profile information (see 

Figure 6-4). The SMI Server Information area has an Edit button you can click to change the SMI 

server information if necessary.  

 

Figure 6-4 SMI Server Information Screen 
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6.5 Viewing Firmware Image Information 

When the xStack Storage icon is selected in the Physical Resources tab, you can use the 

Firmware Image Info screen to view the currently active firmware image being used by the xStack 

Storage Array (see Figure 6-5). This screen also shows other valid firmware images that have been 

used with the xStack Storage Array.  

 

 

For information about upgrading the xStack Storage Array firmware, see 

Appendix E. 

 

 

Figure 6-5 Firmware Image Info Screen 
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6.6 Viewing Storage Pool Information 

When Blade A Base Pool is selected in the Logical Resources tab, you can use the Storage Group 

Information screen to view information about the storage pool (see Figure 6-6).  

The top-left side of the screen shows the storage pool type, amount of free space, total capacity, 

and number of drives. To the right of this information is a pie chart that provides a graphical 

representation of the amount of used and unused (free) space in the storage pool. Used space is 

shown in gray and unused space is shown in green. 

Below this information are rows that correspond to the drives attached to the xStack Storage 

Array. Each row corresponds to a separate drive and shows the drive’s: 

� Slot number 

� State (online, offline, etc.). For readability, the state is color coded (green = online, black = 

offline. 

� Capacity (the actual usable capacity of the drive) 

� Utilization percentage 

� Allocation 

 

Figure 6-6 Storage Group Information 
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6.7 Viewing Storage Pool Tasks 

When Blade A Base Pool is selected in the Logical Resources tab, you can use the Tasks Info 

screen to view tasks scheduled for the storage pool (see Figure 6-7). Examples of tasks include 

media scan and drive initialization activities.  

Each row of the Tasks Info screen corresponds to a task. The last column, Recurring, shows 

whether the task is recurring and will repeat again in the future. 

 

Figure 6-7 Tasks Info Screen 

To obtain additional information about a task shown in the Tasks Info screen, double-click the 

task. A Task Message Details box appears, with detailed information about the task. 
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6.8 Viewing Volume Information 

When you click a volume under Blade A Base Pool, you can use the Volume Information screen to 

view information about the selected volume.  

 

 

The name of the volume appears in the tab., for example, shows information 

for a volume named “dlink.” 

The Volume Information screen shows the following information (see Figure 6-8): 

� The volume’s durable name and size, volume state and cache status, volume type, storage 

efficiency and storage bandwidth, and chunk size. 

� A graphical representation of the drives associated with the volume. 

� A LUN Map that shows the iSCSI target node(s) and LUN Number(s). 

 

Figure 6-8 Example of Volume Information for a Volume Named dlink 
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6.9 Viewing Volume Tasks 

When you click a volume under Blade A Base Pool, you can use the Task Info screen to view tasks 

assigned to the selected volume. Each row of the Tasks Info screen corresponds to a task assigned 

to the volume. The information shown for each task is (see Figure 6-9) 

� The task name 

� The object (volume) assigned the task 

� The task (operation) that is to be performed 

� The progress of the task 

� The status of the task 

� The task’s estimated completion time (ECT) 

� Whether the task is recurring 

 

Figure 6-9 Tasks Info Screen 

To obtain additional information about a task shown in the Tasks Info screen, double-click the 

task. A Task Message Details box appears, with detailed information about the task.  
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6.10 Viewing Information about Drives in the Blade A Base Pool 

When a drive is selected under Blade A Base Pool in the Logical Resources or when a drive is 

selected on the Physical Resources tab, you can view information about the selected drive as 

described in the following sections.  

6.10.1 Viewing Information About Physical Drives 

When a drive is selected under Blade A Base Pool in the Logical Resources or when a drive is 

selected on the Physical Resources tab, the Drive Information screen shows the following 

information about the selected drive (see Figure 6-10). 

� Drive number 

� Vendor model 

� Serial number 

� Physical capacity 

� State (for example, online or offline) 

� Microcode level 

� ATA version 

� Supported and actual line speeds 

� Support for 48-bit addresses and SATA queuing 

� Queue depth 

 

Figure 6-10 Drive Information Screen 
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6.10.2 Viewing SMART Information for a Drive 

Self-Monitoring, Analysis, and Reporting Technology (SMART) is a monitoring system for computer 

hard disks to detect and report on various indicators of reliability, with the hope of anticipating 

failures. With SMART, a hard disk's integrated controller works with various sensors to monitor 

various aspects of the drive's performance, determines from this information if the drive is 

behaving normally or not, and makes available status information to software that probes the 

drive and look at it. 

The xStack Storage Array collects the SMART information and displays it on the management 

console in tow collections. This information consists of: 

� SMART data that serves as a summary of the overall status. 

� SMART attributes that are defined differently by each vendor. 

To view SMART information for a drive, select a drive under Blade A Base Pool in the Logical 

Resources or on the Physical Resources tab. You can then use the second tab to view information 

collected from the SMART data (see Figure 6-11). You may notice a slight delay, as the xStack 

Storage Array polls this information from the drive (SMART data is polled from the drive every 10 

seconds). The third tab displays the SMART attributes in a table (see Figure 6-12). Again, you may 

notice a slight delay, as the information is polled from the drive (the displayed information 

refreshes every 10 seconds). 

 

Figure 6-11 Viewing Collected SMART Data 
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Figure 6-12 Viewing SMART Attributes 
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6.11 Viewing Target Node Information 

When a network entity is selected in the Logical Resources tab, you can use the Target Node Info 

screen to view the session and connection parameters associated with the selected network 

entity.  

 

Figure 6-13 Target Node Info Screen 
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6.12 Viewing Volume Access Information 

When a network entity is selected in the Logical Resources tab, you can use the Volume Access 

Info screen to view LUN map information for the volume associated with the selected network 

entity.  

 

Figure 6-14 Volume Access Info Screen 
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6.13 Viewing Initiator Access Information 

When a network entity is selected in the Logical Resources tab, you can use the Initiator Access 

Info screen to view iSCSI initiator and access information associated with the selected network 

entity.  

 

Figure 6-15 Initiator Access Info Screen 
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6.14 Viewing LAG Port Information 

When a LAG is selected in the Logical Resources tab, the main display shows the LAG Port Info 

screen (see Figure 6-16). This screen is divided into the following sections:  

� LAG port information. This section shows the following information: 

– LAG MAC port address 

– Requested per-port speed 

– Aggregate LAG speed 

– Link status 

– Admin status 

– Ethernet encapsulation 

– VLAN support 

– Auto negotiation 

– MTU 

� Ethernet Port. This area shows the status of each Ethernet port associated with the LAG port. 

To enhance viewing, online ports are shown in green. 

� IP Address. This area shows the IP addresses and corresponding VLAN IDs, if any, associated 

with the LAG port. 

 

Figure 6-16 LAG Port Info Screen 
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6.15 Viewing Network Portal Information 

When a network entity is selected in the Logical Resources tab, you can use the Portals Info 

screen to view the IP address and port number associated with the selected network entity. 

 

Figure 6-17 Portals Info Screen 
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6.16 Viewing Connection Information 

If you select a connection in the Physical Resources tab, you can use the Connection Information 

screen to view the connection parameters and session information for the selected connection 

(see Figure 6-18). 

 

Figure 6-18 Connection Information Screen 
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6.17 Viewing iSCSI Initiator Information 

When an iSCSI initiator is selected in the Logical Resources tab, you can use the Initiator 

Information screen to view information associated with the selected iSCSI initiator (see Figure 

6-19).  

 

Figure 6-19 Initiator Information Screen 
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6.18 Viewing  LUN Map Information 

When an iSCSI initiator is selected in the Logical Resources tab, you can use the LUN Map 

Information screen to view LUN Map information associated with the selected iSCSI initiator (see 

Figure 6-20 

 

Figure 6-20 LUN Map Information Screen 
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6.19 Viewing Ethernet Port Information 

When an Ethernet port is selected in the Physical Resources tab, the main display area shows the 

physical port information for the selected Ethernet port (see Figure 6-21).  

 

Figure 6-21 Physical Port Information 
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Chapter 7 Performing Diagnostics 

For quick fault isolation, the xStack Storage Array provides two ping connectivity tests: 

� One ping connectivity test evaluates the connection between the xStack Storage Array 

management port and the management console. 

� Another ping test evaluates the connection between an xStack Storage Array data port 

and the iSCSI initiator. 

This chapter describes how to perform these ping connectivity tests. 

7.1 Pinging from an xStack Storage Array Network Portal 

Using the Ping from Out of Band dialog box, you can ping in order to ascertain whether a 

remote host can be reached from an xStack Storage Array network portal. This function is 

extremely useful for testing the network port connection to the network, independent of 

any application in which the original problem may have been detected.  

Pinging lets you determine whether further testing should be directed toward the network 

connection (the lower layers) or the application (the upper layers). If ping shows that 

packets can travel to the network and back, the problem is probably in the upper layers. If 

packets cannot make the round trip, lower protocol layers may be at fault. 

To ping from a particular xStack Storage Array network portal, use the following procedure: 

1. In the Logical Resources tab, expand Network Entities, LAG Resources, and the LAG 

that controls the desired network portal by clicking the plus sign (+) to the left of the 

title.  Then right-click the desired network portal and click Ping From. A dialog box 

similar to the one in Figure 7-1 appears. 

 

Figure 7-1. Pinging from a Network Portal 



 

128 Chapter 7 Factory Default Settings 

2. In the IP Address to Ping field, enter the destination IP address of the host. 

3. Click the Ping button. The results of the ping appear in the Results area of the dialog 

box. 

4. When you finish, click the Close button to close the dialog box. 

7.2 Pinging from the xStack Storage Array Management Port 

The Ping Out of Band dialog box also lets you ping or locate the management workstation 

connected to the xStack Storage Array management port. 

To ping from the xStack Storage Array management port, use the following procedure: 

1. Select the Physical Resources tab. 

2. On the File menu, click Ping from Out of Band Port. A dialog box similar to the one in 

Figure 7-2 appears. 

3. In the IP Address to Ping field, enter the destination IP address of the management 

workstation. 

4. Click the Ping button. The results of the ping appear in the Results area of the dialog 

box. 

5. When you finish, click the Close button to close the dialog box. 

 

Figure 7-2. Pinging from the Management Port 
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Appendix A  Factory Default Settings 

This appendix lists the factory-default settings for the xStack Storage Array.  

Table A-1. Configure Out of Band Port Default Settings 

Parameter Default Value 

IP Address After Restart 192.168.1.1 

Subnet Mask After Restart 255.255.255.0 

Hostname After Restart  hn<serial number of xStack Storage Array controller board> 

Gateway After Restart 0.0.0.0. 

 

Table A-2. Battery Policy Default Setting 

Parameter Default Value 

If the battery fails, the xStack Storage Array should Ignore the status of the battery and do nothing (I have a UPS) 

 

Table A-3. Date and Time Default Setting 

Parameter Default Value 

Timezone UTC 

 

Table A-4. Modify System TCPIP Default Settings 

Parameter Default Value 

Max. Segment Size 8960 

Window Scale 0 

Time To Live (TTL) 64 

PMTU Enabled True 

Table A-5. Set Default Task Priority Default Setting 

Parameter Default Value 

Default Priority 5 
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Table A-6. Set Spare Count Default Setting 

Parameter Default Value 

Number of Spare Counts 0 

 

Table A-7. Modify iSCSI Port Default Setting 

Parameter Default Value 

New SCSI Port 3260 

 

Table A-8. Email Notification Support Default Setting 

Parameter Default Value 

Enable Email Notification Support Disabled 

SMTP Server 0.0.0.0 

SMTP Port 25 
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Appendix B  Recording Your Configuration Settings 

This appendix contains tables you can use to record the configuration settings.  Please print 

this out and use it as a hard copy reference.  

B.1  Recording Out-of-Box Settings 

Use Table B-1 to record the initial settings you specify when you run the OOBE setup wizard. 

Table B-1. Out-of-Box Settings 

Parameter Initial Setting 

Management Port Settings 

IP Address  

Subnet  

Default Gateway  

Host name  

Administrator Account Settings 

Admin Password  

Date/Time Settings 

Date and Time  

Time Zone  

Email Notification Settings 

Enable Email Support  

SMTP Server IP Address  

Port Number  

From  

To  
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B.2 Recording Volumes 

Use Table B-2 to record information about the volumes you create. 

Table B-2. Volumes Created Using the xStack Storage Array 

Volume 

Name 

Volume 

Size 

Data Redundancy 

(None, Parity, Mirror) 

Chunk Size Configuration 

(JBOD, Stripe, Mirror, 

Mirrored Stripe, Parity) 

Allocated 

Drives 
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B.3 Recording iSCSI Initiators 

Use Table B-3 to record information about the iSCSI initiators you create. 

Table B-3. iSCSI Initiators Created Using the xStack Storage Array 

Initiator Name Initiator Password 
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B.4 Recording LAGs 

Use Table B-4 to record information about the LAGs you create. 

Table B-4. LAGs Created Using the xStack Storage Array 

LAG 

Number  

(1, 2,…)  

MTU Size Ethernet Encapsulation VLAN 

Supported (Yes 

or No) 

Physical Ethernet 

Ports in This LAG 

Requested 

Speed 
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B.5 Recording Network Portals 

Use Table B-5 to record information about the network portals you create. 

Table B-5. Network Portals Created Using the xStack Storage Array 

LAG 

Number  

(1, 2,…)  

MTU Size Ethernet Encapsulation VLAN 

Supported (Yes 

or No) 

Physical Ethernet 

Ports in This LAG 

Requested 

Speed 
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B.6 Recording iSCSI Target Nodes 

Use Table B-6 to record information about the iSCSI target nodes you create. 

Table B-6. iSCSI Target Nodes Created Using the xStack Storage Array 

iSCSI Node Alias Enable CHAP Secret  

(Yes/No) 

CHAP Secret  

(if Enabled) 

Initiators Selected LUN Number and 

Access Mode 

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     



 

 xStack Storage User’s Guide 137 

B.7 Recording IP Routing Tables 

Use Table B-7 to record information about the IP routing tables you create. 

Table B-7. IP Routing Tables Created Using the xStack Storage Array 

Network 

Destination 

Netmask Gateway Interface Metric 
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B.8 Recording Scheduled Tasks 

Use Table B-8 to record information about the scheduled tasks you create. 

Table B-8. Scheduled Tasks Created Using the xStack Storage Array 

Operation 

Name 

Object Operation Task Frequency 

(Daily, Weekly, Monthly, Once) 

Start Time Start Date 
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Appendix C  Performing Advanced Diagnostics 

The xStack Storage Array provides two menus for performing advanced diagnostics, one that 

can be accessed through the serial port and another that can be accessed through the 

management port. 

The serial port diagnostic menu is accessed during startup. This menu lets you reset all 

admin passwords, download configuration parameters, access the Enclosure Services Test 

Tool, or continue with the boot operation. For more information, see Section C.1. 

The management port diagnostic menu is used if the xStack Storage Array is operational, but 

the management console is not available. This menu lets you reset the xStack Storage Array 

to factory defaults, reboot or shut down the xStack Storage Array, and change the out-of-

band port configuration. To access this menu, you must know the login username and 

password. For more information, see Section C.2. 

C.1 Accessing the Serial Port Diagnostic Menu 

This method requires that you have physical access to the xStack Storage Array itself.  To 

access the xStack Storage Array serial port diagnostic menu, use the following procedure: 

1. Shut down the xStack Storage Array. 

2. Connect a PC to the xStack Storage Array diagnostic serial port using the provided 

female DB9 to female DB9 cable 

From the connected PC, launch a terminal-emulation program configured as follows: 

– Terminal type: VT-100 

– Bits per second: 9600 bps 

– Data bits: 8 

– Parity: None 

– Stop bits: 1 

– Flow control: none 

3. Turn the xStack Storage Array power on. When you are prompted to press the Enter key 

to stop autostart, press Enter. The serial port startup menu in Figure C-1 appears. 

 
Press the Enter key to stop autostart: 

   Startup menu: 

 

1. Reset all admin account passwords 

2. Download configuration 

3. Enclosure Services Test Tool 

4. Continue with boot operation 

 

Enter menu number desired: 

Figure C-1. Serial Port Diagnostic Menu 



 

140 Appendix C Performing Advanced Diagnostics 

5. From the serial port diagnostic menu, type the appropriate number for the option you 

want to perform: 

– To reset all admin account passwords, type 1 and press the Enter key. This selection 

removes every user account that had either Manage Storage or Manage User 

Accounts privileges, and creates a single account with the user name admin and 

password admin (if it doesn’t already exist) with both privileges. After you confirm 

your desire to reset all admin accounts, the Startup menu appears again. Type 4 and 

press Enter to continue to start the xStack Storage Array. 

– To download configuration parameters, type 2 and press the Enter key. Use this 

selection to set the xStack Storage Array configuration from a TFTP server. When 

selected, you are prompted for the IP address of your TFTP server. The next prompt 

requests the file name containing the configuration. After the new configuration is 

downloaded, the Startup menu appears again. Type 4 and press Enter to continue to 

start the xStack Storage Array 

– To access the Enclosure Services Test Tool, type 3 and press the Enter key. 

– To skip the serial port startup menu and continue with the startup operation, type 4 

and press the Enter key. 

C.2 Accessing the Management Port Diagnostic Menu 

If the xStack Storage Array is operational, but the management console is not accessible, 

you can use the following procedure to access the management port diagnostic menu. 

1. Be sure your PC Ethernet port is connected so that it has access to the xStack Storage 

Array management port. There must be physical connectivity, either a direct connection 

or through a switch, and both the PC and the xStack Storage Array must have IP 

addresses on the same subnet. 

2. Telnet to the xStack Storage Array management port. The example Figure C-2 uses a 

Microsoft Windows Telnet application. This screen was accessed by clicking the Start 

button and then clicking Run, typing telnet 192.168.1.1 in the Run dialog box, and 

clicking OK. 
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Figure C-2. Password Prompt 

3. At the login prompt, enter a valid user name (the default is admin) and press the Enter 

key.  

4. At the password prompt, enter the password for that user name (the default is admin) 

and press Enter. The management port diagnostic menu in Figure C-3 appears. 

 

Figure C-3. Management Port Diagnostic Menu 

5. From the management port diagnostic menu, type the appropriate number for the 

option you want to perform: 

- 1 = Reset the xStack Storage Array to factory-default settings (see Section C.2.1) 

- 2 = Reboot or shut down the xStack Storage Array (see Section C.2.2) 

- 3 = Set the out-of-band port configuration (see Section C.2.3) 

- 4 = Quit (exit) the management port diagnostic menu 
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C.2.1 Restoring Factory Defaults 

To reset the xStack Storage Array to factory-default settings, use the following procedure. 

This procedure will require you to restart the xStack Storage Array. 

1. From the management port diagnostic menu, type 1 and press Enter. A prompt asks 

whether you also want to reset the management port IP address (see Figure C-4). 

 

Figure C-4. Prompt for Resetting the Management Port IP Address 

2. To also reset the management port IP address to its default setting, type y. Otherwise, 

type n. 

3. Press Enter. A prompt asks whether you are sure you want to reset the xStack Storage 

Array to factory-default settings (see Figure C-5). 

 

Figure C-5. Prompt for Resetting the xStack Storage Array to Factory-Default Settings 
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4. To reset to the factory-default settings, type y. Otherwise, type n. 

5. Press Enter. The xStack Storage Array restarts. 
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C.2.2 Rebooting or Shutting Down the System 

To reboot or shut down the xStack Storage Array, use the following procedure: 

1. From the management port diagnostic menu, type 2 and press Enter. A prompt asks you 

to enter the number of the desired option (see Figure C-6). 

 

Figure C-6. Prompt for Rebooting or Shutting Down the xStack Storage Array 

 

2. Perform one of the following steps: 

– To reboot the xStack Storage Array, type 1. 

– To shut down the xStack Storage Array, type 2. 

– To cancel the operation and return to the management port diagnostic menu, type 

3. 

3. Press Enter. The xStack Storage Array performs the action that corresponds to the 

number you typed in the previous step. 
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C.2.3 Setting the Out-of-Band Port Configuration 

To set the xStack Storage Array out-of-band configuration, use the following procedure: 

1. From the management port diagnostic menu, type 3 and press Enter. The current xStack 

Storage Array IP address, subnet mask, gateway, and hostname are displayed (see Figure 

C-7) and you are prompted to enter a new IP address for the management port. 

 

Figure C-7. Example of xStack Storage Array Settings 

2. To keep the current IP address for the management port, press Enter. Otherwise, enter 

a new address and press Enter. You are prompted for a subnet mask. 

3. To keep the current subnet mask for the management port, press Enter. Otherwise, 

enter a new subnet mask and press Enter. You are prompted for a gateway. 

4. To keep the current gateway, press Enter. Otherwise, enter a new gateway and press 

Enter. You are prompted for a hostname. 

5. To keep the current hostname, press Enter. Otherwise, enter a new hostname and press 

Enter. A message says you must reboot the xStack Storage Array for the new settings to 

take effect, and then asks whether you want to change the management port IP address. 

6. To reset the management port IP address, type y. Otherwise, type n. If you typed y, the 

new management port settings take effect the next time the xStack Storage Array 

restarts. 
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Appendix D  Replacing and Upgrading FRUs 

This appendix describes how to replace or upgrade the Field Replaceable Units (FRUs) in your 

xStack Storage Array. FRUs that can be replaced or upgraded include: 

� Battery Pack 

� System and buffer memory 

� SATA drives 

� Fans 

� Uninterruptible power supplies 

D.1 Installing the Battery Pack 

The xStack Storage Array accommodates a 4-cell or 6-cell shrink-wrapped battery pack. 

Because write-back caching is always enabled, we recommend you have a battery to back up 

the buffer cache contents. 

To install a battery in your xStack Storage SAN Array, follow these steps: 

1. Hold the battery as shown to align the fastener pad.  Make sure the battery cable and 

connector is located nearest to the battery socket J35 on the controller (see Figure D-1 ).  

 

 

Figure D-1  Aligning the Battery 
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2. Press the battery down firmly as shown in Figure D-2 until you feel it lock into place.  

 

Figure D-2  Press the Battery Down Firmly Until it Locks 

 

3. Align the battery plug with connector J35 as shown in Figure D-3 and insert it fully into 

the socket. 

 

Figure D-3  Align the Battery Plug with Connector J35 
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4. The connector locked firmly into connector J35.  

 

Figure D-4  Battery Plug Locked in Place 

5. The installed battery is shown in Figure D-5. 

 

Figure D-5  The Installed Battery 
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D.2 Installing Memory 

The xStack Storage Array provides four memory sockets: 

� Two sockets (J36 and J37) are for buffer memory 

� Two sockets (J38 and J39) are for system memory 

System Memory: The xStack Storage controller can address up to 2GB of system memory, but 

only 512MB are required for operation of your controller.  Your controller will have come 

standard with at least 512MB (2 x 256MB modules) making upgrading of system memory not 

necessary.  Please see Figure D-6 system memory location. 

Buffer (Cache) Memory:  The xStack Storage controller can address up to 2GB of buffer 

memory, and comes standard with at least 512MB (2 x 256MB modules) installed.  This should 

work well for most applications.  However, several applications (such as video streaming) of 

the product could benefit from increased cache memory.  Please see Figure D-6 for buffer 

memory location.Note on Memory:  The xStack Storage controller’s system and buffer memory 

must be installed as matching pairs.  Table D-1 lists the specifications for DIMMs supported by 

the xStack Storage Array.  These memory module specifications are crucial to the operation of 

your SAN array.  Please visit the www.dlink.com website for tested memory modules. 

Table D-2 shows the possible memory configurations for your xStack Storage controller.  

Please note that you must use matching memory modules for DIMM0 & DIMM1 as well as 

matching memory modules for DIMM2 & DIMM3. 

 

 

Figure D-6  Buffer and System Memory Location 
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Table D-1. xStack Storage Array DIMM Specifications 

Requirement Description 

PC2700/DDR333 speed SDRAMs must be JEDEC compliant and DDR333 capable, with a CAS latency of 2.5. 
PC3200/DDR400 speed DIMMs can be used if they support a 2.5 CAS latency when 
operating at DDR333 speed. 

ECC DIMMs must be organized as x72 bits wide, allowing support for ECC. 

X8 RAMs DIMMs must use 8-bit wide DRAMs that can support data mask (DM) signals. DIMMs that 
use 4-bit-wide DRAMs do not provide DM signals and cannot be used.  

Registered DIMMs must be registered as per the JEDEC specification for registered DIMMs. 

Buffered DIMMs must be buffered as per the JEDEC specification for buffered DIMMs. 

Organization Conforming DIMM organizations are shown in Table D-2.. 

 

 

Table D-2. DIMM Organization 

 

DIMM 0 (J36) 

System 

Memory 

Module 

DIMM 1 (J37) 

System 

Memory 

Module 

Total 

System 

Memory 

DIMM 2 (J38) 

Cache 

Memory 

Module 

DIMM 3 (J39) 

Cache 

Memory 

Module 

Total 

Cache 

Memory 

Total 

Memory 

256MB 256MB 512MB 256MB 256MB 512MB 1GB 

256MB 256MB 512MB 512MB 512MB 1GB 1.5GB 

256MB 256MB 512MB 1GB 1GB 2GB 2.5GB 

256MB 256MB 512MB 2GB 2GB 4GB 4.5GB 
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D.3 Installing or Replacing SATA Drives 

 

Removal of a populated drive/tray assembly can have unforeseen effects 

including the loss of all data in a volume.  A drive can be part of a volume 

that may or may not be redundant.  Before removing a drive from an 

operating xStack Storage Array, make sure it is the correct one. 

D.3.1 Drive and Tray Removal 

A drive/tray assembly can be removed by pressing upwards on the green latch found on the 

tray and removing it with the handle as shown in Figure D-7and Figure D-8. 

 

Figure D-7  Drive and Tray Removal 

 

Figure D-8  Remove Drive/Tray 
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D.3.2 Installing a Hard Drive in a Drive Tray 

Follow these steps to install a hard drive in a drive tray. 

1. Remove the plastic air dam from the tray by squeezing the two levers together and 

lifting the piece out of the tray as shown in Figure D-9.  

 

Figure D-9  Removing the Plastic Air Dam Piece 

2. Your tray should now look like Figure D-10. 

 

 

Figure D-10 Tray with Air Dam Removed 
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3. Place new hard drive in tray as shown in Figure D-11.  

 

Figure D-11  Place Hard Drive in Tray 

4. Align the mounting holes and insert four mounting screws to hold the drive securely in 

the drive tray as shown in Figure D-12.  

 

 

Figure D-12  Secure the Hard Drive in the Drive Tray 
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5. Your hard drive is ready for installation.  Proceed to D.3.3. 

 

D.3.3  Drive and Tray Installation 

A drive/tray assembly can be installed by inserting the drive/tray assembly into the open drive 

bay as shown in Figure D-13.  Push the tray at the point indicated in Step 2 of Figure D-14 and 

push until it is seated firmly within the bay.  As you press, you will see the tray handle begin to 

move inwards as the locking mechanism enters the locking slot.  When you see this, then you 

must push the tray handle inwards as shown in Figure D-15 until you hear the green locking 

mechanism click. 

 

Figure D-13  Drive/Tray Installation 
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Figure D-14  Press Here Until You See the Lever Move Inwards 

 

Figure D-15   Press Lever Inwards Untill it Locks 
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D.4 Replacing a Fan 

The xStack Storage Array contains three user replaceable fans.  They can be replaced as follows. 

1. Locate the failed fan.  They can be identified by their green handle as seen in Figure D-16.  

 

Figure D-16  A User Replaceable Fan with Green Handle 

2. Lift the handle, grasp it and pull the fan upwards as seen in Figure D-17.  

 

Figure D-17  Lift the Handle and Pull Upwards 
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3. Remove the fan from its socket as seen in Figure D-18. 

 

Figure D-18  Remove the Fan 

4. Insert the new fan by reversing the previous steps.  i.e. Insert fan into socket, press firmly 

downwards until it is seated and lower the handle to lock it in place. 
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D.5 Replacing a Power Supply 

The xStack Storage Array contains three user replaceable power supply modules.  They can be 

replaced as follows. 

1. Locate the failed power supply module.  Unscrew the bolt holding the locking mechanism in 

place as shown in Figure D-19.  

 

Figure D-19  Unscrew the Bolt Holding the Locking Mechanism 

2. Push the locking lever to the left and pull on the handle as shown in Figure D-20.  

 

Figure D-20  Push the Locking Lever to the Left and Pull Handle 
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3. Remove the power supply module as shown in Figure D-21.  

 

 

Figure D-21  Remove the Power Supply Module 

 

4. Insert the new power supply module by reversing the previous steps.  i.e. Insert the new 

power supply module into the bay until it seats against the rear and the lever locks.  Then 

screw the locking bolt into place. 
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 xStack Storage User’s Guide 161 

Appendix E Upgrading Firmware 

D-Link periodically updates the firmware for the xStack Storage. The latest firmware 

releases are available at the D-Link Support Web site.  

1. Go to the D-Link Support Web site (support.dlink.com). 

2. Select your product model number from the pull-down menus. 

3. Select the firmware topic. 

4. Download the firmware. 

5. When prompted to save the firmware file, click Save and save the file to a desired 

location. 

 

 

On a piece of paper, write the location and folder where you download the 

firmware file. You will need to access this location later in this procedure. 

6. Launch the xStack Storage Web Manager. 

7. On the View menu, click Firmware Upgrade. The message in Figure E-1 Firmware 

Upgrade Message appears. 

 

Figure E-1 Firmware Upgrade Message 

8. Click OK to continue. (Or click Cancel to exit without upgrading the firmware.) If you 

click OK, the Open dialog box appears (see Figure E-2). 
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Figure E-2 Example of the Open Dialog Box 

9. Navigate to the location where the firmware file you downloaded resides. 

10. Click the firmware file, then click the Open button. (Or as a shortcut, double-click the 

firmware file). The new firmware is installed. A progress bar shows the status of the 

installation. 

11. After the firmware is installed, a message prompts you to press OK to restart the xStack 

Storage to have the new firmware take effect. 

12. Click OK to restart the xStack Storage. If additional messages appear, click OK to 

remove them. 

13. After the xStack Storage restarts, launch your Web browser again and log in to the 

xStack Storage management console. 

 

 

The Firmware Image Info screen shows the current active firmware image 

being used by the xStack Storage. For more information, refer to Section 

6.5. 
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Appendix F Hardware Enclosures 

This appendix shows samples of hardware enclosures for the xStack Storage. 

F.1 Front View 

 

Figure F- 1 Front View of Enclosure 

 

F.2 Back View 

 

Figure F- 2 Rear View of Enclosure 
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Appendix G Acronyms and Abbreviations 

Administrator The person responsible for managing storage operations. The administrator is the 

user who will use the storage management console provided with the xStack Storage. 

CHAP Challenge Handshake Authentication Protocol. CHAP is a protocol for authenticating 

the peer of a connection and is based upon the peers sharing a secret (a security key 

similar to a password). 

CSMA/CD Carrier Sense Multiple Access/Collision Detection. The LAN access method used in 

Ethernet. When a device wants to gain access to the network, it checks whether the 

network is quiet (senses the carrier). If it is not, it waits a random amount of time 

before retrying. If the network is quiet and two devices access the line at exactly 

the same time, their signals collide. When the collision is detected, they both back 

off and each waits a random amount of time before retrying. 

Drive A physical storage drive (usually, but not necessarily, a disk drive) managed by the 

xStack Storage system. 

802.3 An IEEE standard for a CSMA/CD local-area network access method, which is used in 

Ethernet, the most common LAN technology. 

Extent A contiguous set of LBs on a drive. An extent is also called a physical extent. 

IETF Internet Engineering Task Force. The main standards organization for the Internet. 

The IETF is a large open international community of network designers, operators, 

vendors, and researchers concerned with the evolution of the Internet architecture 

and the smooth operation of the Internet. It is open to any interested individual. 

Initiator node An iSCSI node that performs as an iSCSI Initiator in accessing data stored on the 

xStack Storage system. 

IP Internet Protocol. IP specifies the format of packets, or “datagrams,” and the 

addressing scheme. Most networks combine IP with a higher-level protocol called 

Transmission Control Protocol (TCP), which establishes a virtual connection between 

a destination and a source. IP by itself is something like the postal system. It allows 

you to address a package and drop it in the system, but there's no direct link 

between you and the recipient. TCP/IP, on the other hand, establishes a connection 

between two hosts so that they can send messages back and forth for a period of 

time. The current version of IP is IPv4. 

iSCSI Internet Small Computer System Interface. An IP-based standard for linking data 

storage devices over a network and transferring data by carrying SCSI commands over 

IP networks. iSCSI supports a Gigabit Ethernet interface at the physical layer that 

allows systems supporting iSCSI interfaces to connect directly to standard Gigabit 

Ethernet switches and/or IP routers. iSCSI was developed by the IETF and became an 

official standard in February 2003. 
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LAG Link Aggregation Group. The combining of physical network links into a single logical 

link for increased bandwidth. A LAG increases capacity and availability of the 

communications channel between devices using existing Fast Ethernet and Gigabit 

Ethernet technology. LAGs also provide load balancing, where processing and 

communications activity is distributed across several links in a trunk, so that no 

single link is overwhelmed.  

LAN Local Area Network. A computer network that spans a relatively small area. Most 

LANs are confined to a single building or group of buildings. Most LANs connect 

workstations and personal computers. Each node (individual computer) in a LAN has 

its own CPU with that executes programs, but it can also access data and devices 

anywhere on the LAN. This means that many users can share expensive devices, such 

as laser printers, as well as data. Users can also use the LAN to communicate with 

each other, by sending e-mail or engaging in chat sessions. There are many different 

types of LANs. Ethernet is the most common LAN for PCs. 

LB Logical Block. A block of storage stored (and read) by the system. 

LUN Logical Unit Number. According to the SCSI Architectural Model, the number used by 

an iSCSI initiator to access a target’s Logical Unit. In the xStack Storage, a logical 

unit is a volume. 

MAC Address Media Access Control address. A hardware address that uniquely identifies each node 

of a network. 

Member A group of chunks organized vertically in an array. 

Mirror A method for improving reliability of a Volume by providing data redundancy. In a 

mirror volume, data redundancy is provided by recoding every data block on more 

than one drive. 

MPU Management Processor Unit. The PowerPC CPU used for management processing on 

the xStack Storage. 

Node A computer or other device, such as a printer. Every node has a unique network 

address, sometimes called a Data Link Control (DLC) address or Media Access Control 

(MAC) address. 

Parity A way to improve reliability of a volume by providing data redundancy. In a parity 

volume, data redundancy is improved by recording data blocks across multiple drives 

and recording one additional parity block on an additional drive. If any single drive 

fails, the original data can be reconstructed from the remaining blocks. 

PLBN Physical Logical Block Number. The number of an LB on a drive. 

RFC Request for Comments. A series of notes about the Internet started in 1969. An 

Internet Document can be submitted to the IETF by anyone, but the IETF decides if 

the document becomes an RFC. If the RFC gains enough interest, it may evolve into 

an Internet standard. Each RFC is designated by an RFC number. Once an RFC is 

published, it never changes. Modifications to an original RFC are assigned a new RFC 

number. 
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SAN Storage Area Network. A high-speed subnetwork of shared storage devices that 

makes all storage devices available to all servers on a LAN or WAN. As storage 

devices are added to a SAN, they will be accessible from any server in the larger 

network. In this case, the server merely acts as a pathway between the end user and 

the stored data.  Because stored data does not reside directly on any network 

servers, server power is used for business applications, and network capacity is 

released to the end user. 

Server A computer or device on a network that manages network resources. For example, a 

network server is a computer that manages network traffic. Servers are often 

dedicated, meaning that they perform no other tasks besides their server tasks. On 

multiprocessing operating systems, however, a single computer can execute several 

programs at once. A server in this case can refer to the program that is managing 

resources rather than the entire computer.  

Striping A way to improve I/O performance on a volume by splitting data among multiple 

drives. 

Storage pool A collection of drives used as a group for common functions (for example, the space 

used by a volume must be allocated from a specific storage pool). 

Subnet A portion of a network that shares a common address component. On TCP/IP 

networks, subnets are defined as all devices whose IP addresses have the same 

prefix. For example, all devices with IP addresses that start with 100.100.100. are 

part of the same subnet. 

TCP Transmission Control Protocol. Pronounced as separate letters, TCP is a main 

protocol in TCP/IP networks. Whereas the IP protocol deals only with packets, TCP 

enables two hosts to establish a connection and exchange streams of data. TCP 

guarantees delivery of data and also guarantees that packets will be delivered in the 

same order in which they were sent. 

VLBN Virtual Logical Block Number. The number of an LB within a volume. The LB is used 

to store customer data. 

Volume A fixed amount of storage on a disk. The term volume is often used as a synonym for 

the storage medium itself, but it is possible for a single disk to contain more than 

one volume or for a volume to span more than one disk. 
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